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INSTALLATION PROCEDURE

Software installation is to be done on a computer that meets
minimal requirements only.

Please read carefully Chapter 2 of the DaTQUANT User
Installation & Activation Guide before software installation.

All user guides are located in the installation package in
folder “Help”.

WARNING: Please make sure to close all applications
prior to beginning installation.

It is highly advised to backup all important data before
proceeding with the installation.

Install the application

After downloading the DaTQUANT package save it to your
hard drive.

Run the installation package and proceed with the
instructions on the screen to complete the installation
procedure.

The software installation requires a computer restart upon
completion.
Uninstall the application or Insite Remote Service

To uninstall the entire application run the installation
package and choose Remove/Modify or from the system
control panel.

Install the license

Follow the on-screen instructions in the activation and
registration tool available from the Start menu.

Launching the application

Launching the application can be done from the Start menu
or from the desktop shortcut.

Download the installation package to the
computer or a portable drive

You will receive an e-mail from

GE Customer Service containing your
order number and GE System ID
(save this information)

2]

'

Run the installer on a computer with
Windows version 7 or 10.
Administrator rights are required.

'

—_— At the end of installation, complete the
\@/\ Registration form and click at the bottom to
generate and send an e-mail to GE to
request activation.

'

Within 1 business day, you will receive an
e-mail from GE Customer Service
containing the activation file (save this)

#

Save the activation file to the computer hard
drive, open the DaTQUANT Activation form,
click “Browse” and select the saved file.
Administrator rights are required.

'

Technical and applications support are
available by telephone during GE
business hours. If support is required
during installation or at any time, you will
need to provide your GE System ID.




SAFETY AND REGULATORY
INFORMATION

Unique Device Identifier (UDI)

The UDI code can be found in the application’s About
screen, which can accessed via any of the following:
Applications >About / Help >About /
Start>DaTQUANT >Tools.

Documentation

To assure an efficient and safe use of DaTQUANT, it is
essential for you to read the supplied User Guides before
attempting to start. The entire documentation is available
in your installation package.

Make certain that your documentation is readily available at
all times. You shall under no circumstances use DaTQUANT
if the documentation is not available. If you need help,
please contact the GE representative.

Indication of use

DaTQUANT application enables visual evaluation and
quantification of 'I-loflupane (DaTscan™) images. The
DaTQUANT Normal Database enables quantification
relative to normal population databases of '2I-loflupane
(DaTscan™) images. This application may assist in
detection of loss of functional dopaminergic neuron
terminals in the striatum, which is correlated with Parkinson
disease.

Electronic Information For Use

F=——N\

This software is delivered with an operator manual set

supplied as electronic Information For Use (elFU). This is

indicated by the label in the software using the icon

displayed above.

The operator manual set is accessible at any time from the

help menu in the upper right corner of the application

screen.

To download the latest operator manual CD and view or

print its content:

1. Access https://www.gehealthcare.com/
support/support-documentation-library

2. Select NM (Nuclear Medicine) link from the list of
modalities. This will open a new page.

3. Under NM Products, select the NM DaTQUANT
product.

4. Select Manual Types: CD.

Click [Search].

Under Download, select the Operator CD in the

appropriate language.

Click [Download Selected Files].

Read the Copyright and click [ACCEPT].

Click [Save] and select path for download.

0. Click [Open Folder] and unzip the downloaded file to

access the material.
Note: Only for EU Member States

If not already provided with the system, a paper copy of the
operator manual set can be ordered at no additional cost.
Send a request to your Sales or Service representative.
Your request should be treated within 7 days.

This paper copy might vary slightly from the electronic copy

on your system. If necessary, contact your local
representative for clarification.

o o
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I:l Date of manufacture @

Refer to the Instruction manual/ | Rx Only
booklet

Label icon | Description Label icon | Description Label icon | Description
Catalog number Manufacturer Instructions for Use are
Reference number d supplied in electronic form
=

Caution: Federal law restricts
this device to sale by or on the
order of a physician
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Bbbnarapcku

NPOLIEQYPA 3A UHCTAJIMPAHE

CobTyepbT TpsibBa Aa Ce MHCTanMpa caMo Ha KOMMIOTbLP,
KOWTO OTroBapsi Ha MUHUMAITHUTE U3WUCKBAaHMS.

Monsi, npoyeTeTe BHUMATENHO rnaea 2 oT "HapbyHuK Ha
nompebumersi 3@ UHCMasnupaHe U akmusupaHe" Ha
DaTQUANT npeau nHctanupaHeTo Ha codTyepa. Benukmn
HapbYHULM 3a NOTpebuTens ce HamMmmpar Ha
MHCTanaumoHHKs nakeT B nankata "Help" (MomoLy).

NMPEAYNPEXOEHUE: YBepeTe ce, Ye cTe 3aTBOpPUNMU
BCUYKM NPUNOXEHUA, Npean Aa 3anoyHeTe
WHCTanupaHeTo.

CunHo ce npenopbyBa Aa HanpaBuTe pe3epBHO Konue Ha
BCWYKM BaXKHU AaHHW, Npeaun Aa Npoabiikute ¢
MHCTanmMpaHeTo.

WUHcTanupaHe Ha npunoxeHneTo

Cnegp kato nsternute naketa DaTQUANT, ro 3anvweTte Ha
BalLUSi TBbPA AMUCK.

CrapTupainTe UHCTanaumMoHHWS NakeT U NPOAbIKETE C
VHCTPYKLMWUTE OT eKkpaHa, 3a Ja 3aBbpLunTe npoueaypara
3a UHCTanupaxe.

Cnep npukrioyBaHe Ha MHCTanMpaHeTo ce Hanara aa
pecTapTupaTte KOMMITbPa.

[denHcTanupaHe Ha NPUNOXEHNETO UMK oTAaneyYeHaTa
ycnyra InSite

3a Aa genHcTanuparte LSNoTO NPUNoXeHue, ctaptupainTe
MHCTanaunoHHnsa nakeT n n3bepete Remove/Modify
(MpemaxeaHe/MoaunduumpaHe) unu HanpaseTe ToBa OT
CUCTEMHUS KOHTPOSEH NaHen.

WHcTanupaHe Ha nuueH3a

CnepfBaiiTe MHCTPYKUMUTE OT eKpaHa B MHCTpyMeHTa 3a
aKTVBMpaHe U PerncTpauusi, KOUTO Ce Hamupa B MEHIOTO
Start (Ctapr).

CTapTupaHe Ha NPUNoXeHNeTo

CTapTupaHeTo Ha NPUIMOXEHNETO MOXE [a Ce U3BbPLUM OT
MeHtoTo Start (CTapT) unm oT UKoHa 3a Npsik MbT Ha paBboTHUSA
nrnor.

M3TerneTe MHCTanauvoHHUs NakeT Ha
KOMMIOTbPa UMK Ha NPEHOCMMO
YCTPONCTBO

LLle nonyunte nmenn ot otaen
"O6cnyxBaHe Ha knneHTU" Ha GE,
CcbAbpXaLl HoMepa Ha 3asiBkata n [ Ha
cuctemarta GE

(3anaseTe Ta3u nHdopmaums)

2]

CrapTupaiite nHcTanaTopa Ha KOMMTbP C
Windows Bepcusi 7 unm 10.

Heobxod0umu ca aOMuHUCMpPamopcKu
npasea.

B Kkpasi Ha MHCTanaumsiTa NnonbnHeTe
pervcTpaunoHHaTta chopma U LpakHeTe B
[lonHaTa 4acT, 3a Aa ce reHepupa un
nsnpatu nmenn go GE 3a 3asBka 3a
aKTBaums.

B pamkute Ha 1 paGoTeH AeH Bue Lie
nony4ute nmewn ot otaen "O6cnyxsaHe
Ha knueHTn" Ha GE, cbabpxaly dann 3a
aKkTvBMpaHe (3anasete ro)

-—p

Mpe3 paboTtHo Bpeme Ha GE Ha
pa3nonoxeHue e TexHMYeckaTa NoaapbXKKa v
noaapbXkKa Ha NpUNoXeHMeTo no TenedoHa.
AKo ce noucka NomoLL, Nno Bpeme Ha
MHCTanaumsiTa unum rno BCAKO ApYro Bpeme, e
Heobxoaumo aa npegoctasute ceos I Ha
cuctemarta GE.

3anaseTte daina Ha akTMBUpaHe Ha TBbpANS ANCK

Ha KOMMITbPa, OTBOpeTe hopmata 3a

aktuBupaHe Ha DaTQUANT, HaTucHeTe "Browse"

(Mpernepn) n n3bepete 3anameTeHnsa dann.
Heobxo0umu ca aOMUHUCMpPamopcKu rpasa.



Bbbnarapcku

NHOOPMALUNA 3A BE3OINACHOCT U
HOPMATUBHA NH®OPMALUA

YHukaneH naeHtudmkatop Ha yctporcteo (UDI)

KoabT UDI moxe na 6bae oTkpuT Ha ekpaHa About
(OTHOCHO) Ha NPUNOXEHNETO, B KOWTO MOXe Aa ce Bneae no
e[VH OT CnefHNTe HauYMHU:

Applications >About (Mpunoxexns > OTHOCHO) /

Help > About (Momouy > OtHocHo) / Start > DaTQUANT
>Tools (Ctapt > DaTQUANT > UHCTpymeHTH).

[okymeHTauumsa

3a obesneyaBaHe Ha edekTnBHaTa 1 6esonacHa ynotpeba
Ha DaTQUANT e 3agbmxuTenHo ga npoyetete
npegocTaBeHnTe "PbKkoBOACTBa 3a NoTpebuTens"”, npeau
[a ce onuTaTe fa ro ctaptupaTte. Lisnata fokymeHTaums ce
Hamyvipa BbB BalLMSA MHCTaNaLUMOHEH NnakeT.

YBepeTe ce, Ye LAnaTa JOKyMeHTauus € NecHoO AOCTbIHA
npes usnoto Bpeme. Mpu H1KakBK obCcTOATENCTBA HE
TpsibBa aa nanonseate DaTQUANT, ako AokyMeHTauusita
He e HanuyHa. Monsi, cebpkeTe ce ¢ npefcTasuten Ha GE,
ako BM e Heobxoavma nomoLy,.

MokasaHus 3a ynotpe6a

Mpunoxenneto DaTQUANT nossonsiBa Bu3yanHa oLeHka u
KonMyecTBeHa oueHka Ha ?°l-nocdnynaH (DaTscan™)
n3obpaxeHusi. HopmanHata 6a3a gaHHum Ha DaTQUANT
no3BorsiBa KONMYECTBEHA OLieHKa, CpaBHKUMa ¢ 6asa
[aHHUTe C HopMarnHa nonynaumsa Ha '#l-nodgnynaH
(DaTscan™) nsobpaxeHus. ToBa NPUNOXeHNe Moxe Aa
noAnoMOrHe ycTaHOBSIBaHETO Ha 3aryba Ha dyHKLMOHanH
KpauLia Ha AonamyHepruiyHW HEBPOHW B CTpMaTyMa, KoeTo
€ B3alMHO cBbp3aHo ¢ bonecTTta Ha MapKUHCOH.

EnekmpoHHa uHghopmauyus 3a
ynompeba

Tosu codpTyep ce npegocTass 3aegHO C PbKOBOACTBO Ha
onepaTopa, CbCTaBEHO KaTo eNeKTPOHHO PLKOBOACTBO 3a

ynoTpe6a (elFU). Toa e 0603Ha4eHo 4pe3 Tabenkata B
cobTyepa C NoMoLLTa Ha nokasaHaTa no-rope UKoHa.

PbKOBOACTBOTO Ha ornepaTtopa e JOCTLIHO MO BCSIKO BpeMe
OT MEHIOTO 3a MOMOLL, B TOPHUSI JECEH KpaW Ha ekpaHa Ha
MPUIOXKEHUETO.

3a fa naternuTe Ham-akTyanHus KOMNakT-aucK ¢
PBLKOBOACTBO Ha onepaTopa 1 Aa npernegare unv aa
pasnevataTe CbAbpXaHUeTO My:

1. Bne3teBhttps://www.gehealthcare.com/
support/support-documentation-library

2. MW3beperte Bpb3kata NM (HykneapHa meamumHa) ot
cnvcbka ¢ moganHocTu. Taka e ce 0TBOpM HoBa
cTpaHunua.

3. B NM Products (NM npogykTtn) nsbepete npogykt NM
DaTQUANT.

4. W3bepete Manual Types: CD.

5. WpakHeTe [Search] ([TvpceHe]).

6. Ot Download (M3ternsHe) n3bepere CD 3a onepatopa
Ha CbOTBETHUS €3UK.

7. LlWpakHete Bbpxy [Download Selected Files]
([N3TernsHe Ha n3bpanute dannose)).

8. [lpoueTeTe Genexkara 3a aBTOPCKUTE Npaea u
HatucHete [ACCEPT] ([MPUEMMU]).

9. LpakHeTe BbpxyY [Save] ([3anuwu]) n nocoyerte
MSCTOTO, KbAETO Aa Ce 3anuLar.

10. LWpakHeTe [Open Folder] ([OTBopu nankata]) n
pasapxvBupanTe naterneHus danin, 3a ga oTBopuTe
matepuana.

3abenexka: oTHacsA ce camo 3a cTpaHu-4YneHku Ha EC

AKO O MOMEHTA He BU € NPeaoCTaBEHO NeyaTHO Konue Ha
PBKOBOACTBOTO Ha onepaTtopa KbM cucteMata, MoXxeTe Aa
ro nopbyare, 6e3 Aa e HeobxoaMmo da gonnaiaTe.
ManpaTeTe 3asBKa 4O NpeacTaBUTENs Ha OTAEN Npoaaxou
Unn TexHnyecko obenyxsaHe. Balwara 3asBka Lie 6bae
obpaboTeHa B pamMkuTe Ha 7 OHW.

Bb3MOXHO e neyaTHOTO M3aaHue Neko Aa ce pasnuyasa oT
e1IeKTPOHHOTO KOMWe, MHCTanMpaHo B cuctemata. Ako e
Heobxoaumo, ce ob6bpHeTE KbM MECTHUA NpeAcTaBmTen 3a
[OMbHUTENHU CBEAEHNS.

WkoHa Ha
eTukeTa

WkoHa Ha Onucanue

eTuketa

Onucanue

WkoHa Ha Onucanue

eTuketa

KatanoxeH Homep
PecbepeHTeH Homep

aeal

MpowussoauTen

WHcTpykumnTe 3a ynotpeba ce
AOCTaBAT B €NEeKTPOHEH
copmar

o]

[aTa Ha npoun3BoACTBO @

BwxTe pbkoBOACTBOTO C
VHCTPYKLMWU/KHWKKaTa

Rx Only BHVUMAHMUE: ®epepanHoTo
3akoHopatencteo Ha CALL

orpaHuyaBa npopax6arta Ha
TOBa YCTPOMCTBO OT UMK MO

HapexpaaHe Ha nekap.
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POSTUP INSTALACE

Instalace softwaru musi byt provedena pouze na po¢itaci,
ktery splfiuje minimalni pozadavky.

Pred instalaci softwaru si prectéte peclivé kapitolu 2 —
UZivatelska prirucka pro instalaci a aktivaci DaTQUANT.
VSechny uzivatelské pFiru¢ky se nachazeji v instalacnim
bali¢ku ve slozce ,Help (Napovéda)“.

VAROVANI: Nez zahajite instalaci, zkontrolujte, Ze jsou
ukonéeny vSechny aplikace.

Durazné se doporucuje pred zahajenim instalace zalohovat
v8echny dllezité udaje.

Instalace aplikace

Po staZeni balic¢ek DaTQUANT ulozte na pevny disk.
Spustte instalacni bali¢ek a pokracujte podle pokynd na
obrazovce, dokud nedokongite postup instalace.

Instalace softwaru vyzaduje po dokonéeni restartovani
pocitace.

Odstranéni instalace aplikace nebo vzdalené sluzby
InSite

Chcete-li odstranit instalaci celé aplikace, spustte instala¢ni
bali¢ek a vyberte moznost Remove/Modify (Odstranit/
upravit) nebo odstrarite jeji instalaci z ovladaciho panelu
systému.

Instalace licence

Postupuijte podle pokynu na obrazovce v aktivacnim

a registracnim nastroji, ktery je k dispozici v nabidce Start
(Spusténi).

Spusténi aplikace

Spusténi aplikace Ize provést z nabidky Start (Spusténi)
nebo ze zastupce na plose.

Stahnéte instalacni bali¢ek do pocitace
nebo na pfenosny disk.

Obdrzite e-mail od zékaznického servisu
spole€nosti GE, ktery obsahuje ¢islo vasi
objednavky a GE System ID (ID systému GE)
(tyto udaje si ulozte)

2]

#

Spustte instalaéni program na pocitaci

s operacnim systémem Windows verze 7,
nebo 10.

Jsou vyZadovana Administrator rights
(Opravnéni spréavce).

Na konci instalace vypliite formular
Registration (Registrace) a klepnutim sem
v dolni ¢asti vygenerujete a odeslete e-mail
spolecnosti GE se Zadosti o aktivaci.

'

Do 1 pracovniho dne obdrzite e-mail od
zakaznického servisu spole¢nosti GE, ktery
obsahuje aktiva¢ni soubor (ulozte jej)

v

DaTQUANT, klepnéte na moznost ,Browse
(Prochazet) a vyberte ulozeny soubor.
Jsou vyZadovana Administrator rghts
(Opravnéni spravce).

'

Technicka podpora a podpora aplikaci jsou
k dispozici prostfednictvim telefonu

v prubéhu pracovni doby spole¢nosti GE.
Pokud budete potfebovat podporu béhem
instalace nebo kdykoliv jindy, budete muset
poskytnout ID systému GE.

Ulozte aktivacni soubor na pevny disk pocitace,
otevrete Activation form (Formular aktivace)



INFORMACE TYKAJICi SE BEZPECNOSTI
A REGULACGNICH PREDPISU

Unique Device Identifier (UDI) (Unikatni identifikator
zarizeni (UDI))

Kaéd UDI naleznete na obrazovce aplikace About (O aplikaci),
ke které ziskate pfistup prostfednictvim nékteré z nasledujicich
moznosti:

Applications (Aplikace)>About (O aplikaci) /

Help (Napovéda) >About (O aplikaci) / Start (Spusténi)>
DaTQUANT >Tools (Nastroje).

Dokumentace

Abyste zajistili efektivni a bezpe¢né pouziti aplikace
DaTQUANT, je naprosto nezbytné, abyste si pred

zahajenim precetli uzivatelskou pfiru¢ku. Veskera
dokumentace je k dispozici ve vaSem instala¢nim balicku.

Zaijistéte, aby vase dokumentace byla stale bez obtizi
dostupna. Za zadnych okolnosti nesmite pouzivat aplikaci
DaTQUANT, pokud dokumentace neni k dispozici. Budete-li
potfebovat pomoc, obratte se na zastupce spole¢nosti GE.
Indikace pouziti

Aplikace DaTQUANT umoziiuje vizudlni vyhodnocovani

a kvantifikaci obrazti '2%l-joflupanu (DaTscan™). MozZnost
DaTQUANT Normal Database (Normalni databaze)
umozriuje kvantifikaci relativné k databazim obrazl '23I-
joflupanu (DaTscan™) normalni populace. Tato aplikace
muze pomahat pfi detekci ztraty funkénich
dopaminergickych neuronovych terminalli ve striatu, ktera
souvisi s Parkinsonovou chorobou.

Elektronické informace o pouZivani
F=——N\

Tento software je dodavan se sadou navodu k obsluze
oznacenou jako elektronické informace o pouzivani elFU
(Elektornicky navod k obsluze). Je to oznac¢eno Stitkem na
softwaru pouzivajicim ikonu zobrazenou vyse.

Sada navodu k obsluze je kdykoli pfistupna z nabidky
napoveédy v hornim pravém rohu obrazovky aplikace.

Chcete-li stdhnout nejnové;jsi disk CD navodu k obsluze a
prohlédnout si nebo vytisknout jeho obsah:

1. Pristup https://www.gehealthcare.com/
support/support-documentation-library

2. Zvolte odkaz NM (Nuklearni medicina) ze seznamu
modalit. Timto oteviete novou stranku.

3. V moznosti NM Products (Produkty NM) vyberte
produkt NM DaTQUANT.

4. Vyberte moznost Manual Types: CD (Typy pfirucky:
CD).

5. Klepnéte na tlagitko [Search] ([Hledat]).

6. V moznosti Download (Stahnout) vyberte Provozni
disk CD v pfislusném jazyce.

7. Klepnéte na moznost [Download Selected Files]
([Stédhnout vybrané soubory]).

8. Prectéte si Copyright (Autorska prava) a klepnéte na
moznost [ACCEPT] ([Pfijmout]).

9. Klepnéte na moznost [Save] ([UloZit]) a vyberte cestu

pro stahovani.

Klepnéte na moznost [Open Folder] ([Otevfit slozku]) a

rozbalte stazeny soubor, abyste ziskali pfistup

k materialu.

10.

Poznamka: Pouze pro ¢lenské staty Evropské unie

Pokud nebyla dodana s produktem, je mozné objednat
papirovou sadu navodu k obsluze bezplatné. Zaslete Zadost
svému zastupci prodeje nebo servisu. Vase zadost by méla
byt vyfizena do 7 dnu.

Tato papirova kopie se muze trochu liSit od elektronické
kopie ve vaSem systému. Bude-li to nutné, obratte se na
svého mistniho zastupce, ktery vam poskytne objasnéni.

Ikona Popis lkona Popis lkona Popis
Stitku Stitku Stitku
Katalogové ¢islo Vyrobce Navod k obsluze se dodava
Referencni &islo d v elektronické forme
=
Datum vyroby Prectéte si navod k obsluze/ Rx Only UPOZORNEN:I: Federalni
& @ pirucku prévo omezuje prodej tohoto
zafizeni pouze na objednavku
lékare.

10
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Kvantitativ software til DaTscan ™" loflupane (1 23[)-billeddannelse

DaTQUANT folder med elFU og brugeroplysninger

ADVARSEL:
Laes sikkerhedsinstruktionerne i denne brochure.

Tilhgrer General Electric Company Inc.
Copyright © 2020, General Electric Company Inc. Alle rettigheder forbeholdes

C € 0459

Kun RX

4 Hayozma Street
Tirat Hacarmel, 30200

] 2020-03

5507043-199 Rev. 4 Softwareversion: 2.0

I GE Medical Systems Israel, Functional Imaging



INSTALLATIONSPROCEDURE

Softwareinstallationen skal udfgres pa en computer, der blot
opfylder minimumskravene.

Laes omhyggeligt kapitel 2 i DaTQUANT installations- og
aktiveringsvejledningen fer softwareinstallationen. Alle
brugervejledninger findes i installationspakken i mappen
"Help".

ADVARSEL: Serg for at lukke alle applikationer, for
installationen pabegyndes.

Det anbefales at sikkerhedskopiere alle vigtige data, fer du
fortsaetter med installationen.

Installer applikationen

Efter du har downloadet DaTQUANT-pakken, skal du
gemme den pa din harddisk.

Ker installationspakken, og fortseet med instruktionerne pa
skeermen for at fuldfare installationsproceduren.

Softwareinstallationen kraever en genstart af computeren
efter fuldfgrelse.

Afinstaller aplikationen eller InSite Remote Service

For at afinstallere hele applikationen skal du kere
installationspakken og veelge Remove/Modify (Fjern/Andr)
eller afinstallere det fra systemets kontrolpanel.

Installer licensen

Folg anvisningerne pa skeermen i aktiverings- og
registreringsveerktgjet, der er tilgaengeligt fra startmenuen.
Start applikationen

Applikationen kan startes fra startmenuen eller fra
skrivebordsgenvejen.

Download installationspakken til
computeren eller et baerbart drev

Du vil modtage en e-mail fra
Kundeservice med dit bestillingsnummer
og GE System ID (GE system-id)

(Gem disse oplysninger)

2]

'

Ker installationsprogrammet pa en
computer med Windows-version 7

eller 10.

Administrator rights (Administrator-
rettigheder) er péliaevet.

Nar installationen er afsluttet, skal du
udfylde formularen Registration
(Registrering) og klikke nederst for at
generere og sende en e-mail til GE for at
anmode om aktivering.

'

Inden for 1 arbejdsdag vil du modtage en
e-mail fra GE Kundeservice, som
indeholder aktiveringsfilen (gem denne)

'

(Gennemse), og vaelg den gemte fil.

pakreaevet.

v

Teknisk support og support til
applikationer er tilgaengelig via telefon i
GE's abningstider. Hvis der er behov for
support under installationen eller pa
noget tidspunkt, har du brug for at kunne
oplyse dit GE system-id.

Gem aktiveringsfilen p4 computerens harddisk, abn
DaTQUANT-aktiveringsformularen, klik pa "Browse

Administrator rights (Administratorrettigheder) er
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OPLYSNINGER OM SIKKERHED OG
LOVGIVNING

Unique Device Identifier (UDI) (Entydigt enheds-id)

UDI-koden kan ses pa skeermbilledet About (Om), som du
kan abne pa falgende mader:

Applications>About / Help>About / Start>DaTQUANT>
Tools (Applikationer > Om / Hjeelp >Om / Start >
DaTQUANT >Veerktgijer).

Dokumentation

For at sikre effektiv og sikker brug af DaTQUANT er det
vigtigt, at du laeser de medfglgende brugervejledninger, for
du prover at starte. Den fuldstaendige dokumentation er
tilgeengelig i din installationspakke.

Searg for, at din dokumentation altid er lige ved handen. Du
ma under ingen omstaendigheder bruge DaTQUANT, hvis

dokumentationen ikke er tilgaengelig. Hvis du har brug for

hjeelp, bedes du kontakte GE-repaesentanten.

Tilsigtet brug

DaTQUANT-applikationen muligger visuel evaluering og
kvantificering af '?l|-ioflupane (DaTscan™) billeder.
DaTQUANT Normal Database aktiverer kvantificering i
forhold til normale populationsdatabaser for 12%|-ioflupan
(DaTscan™) billeder. Denne applikation kan hjaelpe med
registreringen af tab af funktionelle dopaminergiske
neuronterminaler i striatum, som korrelerer med Parkinsons
sygdom.

Elektronisk brugsanvisning

F=——N\

Denne software leveres med et brugerhandbogssaet i form
af en elektronisk brugsanvisning. Dette er angivet via
betegnelsen i softwaren ved hjeelp af det ikon, der er vist
ovenfor.

Saettet af brugerhandbeger er tilgaengeligt nar som helst fra
hjaelpemenuen i gverste hgjre hjgrne af
applikationsskaermen.

Sadan downloader du den seneste brugerhandbogs-cd og
far vist eller udskriver indholdet pa den:

1. Adgang https://www.gehealthcare.com/
support/support-documentation-library

2. Velg linket NM (nuklearmedicin) i listen over
modaliteter. Derved abnes en ny side.

3. Veelg NM DaTQUANT-produktet under NM Products
(NM-produkter).

4. Velg Manual Types: CD (Manuelle typer).

5. Kiik pa [Search] ([Seg]).

6. Veelg operatgr-cd'en pa det relevante sprog under
Download.

7. Klik pa [Download Selected Files] ([Download valgte
filer]).

8. Lees oplysningerne om copyright, og klik pa [ACCEPT]
([GODKEND]).

9. Kiik pa [Save] ([Gem]), og veelg sti til placering af det,
der downloades.

10. Klik pa [Open Folder] ({Abn mappe]), og pak den
downloadede fil ud for at fa adgang til materialet.

Bemaerk: Gaelder kun for EU-medlemsstater

Hvis det ikke allerede medfalger med systemet, kan en
papirkopi af brugerhandbogsseettet bestilles uden ekstra
beregning. Send en anmodning til din salgs- eller
servicerepraesentant. Din anmodning bgr behandles inden
for 7 dage.

Denne papirudgave kan variere en smule fra den
elektroniske kopi pa dit system. Om ngdvendigt kan du
kontakte din lokale repraesentant for afklaring.

Maerkatikon | Beskrivelse Markatikon | Beskrivelse Maerkatikon | Beskrivelse
Katalognummer Producent Brugsanvisning medfglger i
Referencenummer d elektronisk form
=
Fremstillingsdato Se brugsanvisningen/ Rx Only FORSIGTIG: Ifelge
&I @ brochuren amerikansk lovgivning ma

dette apparat kun szelges af
eller efter anvisning fra en
leege.
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INSTALLATIONSVERFAHREN

Die Software-Installation darf nur auf einem Computer
durchgefiihrt werden, der die Mindestanforderungen erfillt.
Bitte lesen Sie vor der Software-Installation Kapitel 2 des
DaTQUANT ,User Installation & Activation Guide*”
(Benutzerhandbuch zu Installation und Aktivierung)
sorgfaltig durch. Alle Benutzerhandblicher finden Sie im
Installationspaket im Ordner ,Help“ (Hilfe).

WARNUNG: Stellen Sie sicher, dass alle Anwendungen
geschlossen sind, bevor Sie mit der Installation
beginnen.

Es wird dringend empfohlen, alle wichtigen Daten zu
sichern, bevor Sie mit der Installation beginnen.
Installieren der Anwendung

Speichern Sie das DaTQUANT-Paket auf Ihrer Festplatte,
nachdem Sie es heruntergeladen haben.

Fihren Sie das Installationspaket aus, und folgen Sie den
Anweisungen auf dem Bildschirm, um den
Installationsvorgang abzuschliefRen.

Nach Abschluss der Software-Installation muss der
Computer neu gestartet werden.

Deinstallieren der Anwendung oder des InSite-Remote-
Service

Wenn Sie die gesamte Anwendung deinstallieren méchten,
fuhren Sie das Installationspaket aus und wéahlen Sie in der
Systemsteuerung ,Remove/Modify* (Entfernen/Andern) aus.
Installieren der Lizenz

Folgen Sie den Bildschirmanweisungen des Aktivierungs-
und Registrierungstools, das tber das Meni ,Start*
aufrufbar ist.

Starten der Anwendung

Die Anwendung kann tber das Menu ,Start” oder Uber eine
Desktopverknlpfung gestartet werden.

Laden Sie das Installationspaket auf den
Computer oder auf eine externe
Festplatte herunter.

Sie erhalten eine E-Mail vom GE-
Kundenservice mit Ihrer Bestellnummer
und der GE-System-ID

(bitte bewahren Sie diese
Informationen auf).

2]

'

Flhren Sie das Installationsprogramm
auf einem Computer mit Windows 7 oder
10 aus. Es sind ,Administrator rights“
(Administratorrechte) erforderlich.

#

Fillen Sie nach Abschluss der Installation
das Formular ,Registration" (Registrierung)
aus, und klicken Sie unten, um eine
Aktivierungsanfrage zu erzeugen und per
E-Mail an GE zu versenden.

'

Innerhalb eines Arbeitstages erhalten Sie
vom GE-Kundendienst eine E-Mail mit der
Aktivierungsdatei (bitte speichern Sie

diese ab).

-—p

v

Innerhalb der Gblichen Blrozeiten hilft lhnen
der GE-Kundendienst gerne bei technischen
Problemen und Fragen zu Anwendungen
weiter. Wenn Sie wahrend der Installation oder
zu einem spateren Zeitpunkt Unterstitzung
durch den Kundendienst bendtigen, halten Sie
bitte stets Ihre GE-System-ID bereit.

Speichern Sie die Aktivierungsdatei auf der Festplatte
Ihres Computers ab, 6ffnen Sie das DaTQUANT
LActivation form“ (Aktivierungsformular), klicken Sie auf

,Browse" (Durchsuchen), und wahlen Sie die gespeicherte

Datei aus.

Es sind ,Administrator rights” (Administratorrechte)
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SICHERHEITSINFORMATIONEN UND
BESTIMMUNGEN

Unique Device Identifier (UDI)
(Produktidentifizierungsnummer [UDI])

Den UDI-Code finden Sie in der Anwendung unter About
(Info). Sie haben die folgenden Mé&glichkeiten, um diesen
Bildschirm aufzurufen:

Applications (Anwendungen) >About (Info) /

Help (Hilfe) >About (Info) / Start>DaTQUANT >

Tools (Werkzeuge).

Dokumentation

Um eine sichere und effiziente Verwendung von
DaTQUANT sicherzustellen, miissen die zur Verfiigung
gestellten Benutzerhandblcher vor dem Startversuch
gelesen werden. Die gesamte Dokumentation ist in Ihrem
Installationspaket enthalten.

Stellen Sie sicher, dass Ihre Dokumentation stets zum
Nachschlagen bereit liegt. Verwenden Sie DaTQUANT auf
keinen Fall, wenn die Dokumentation nicht zur Verfigung
steht. Wenden Sie sich an einen GE-Kundendienstvertreter,
wenn Sie Hilfe bendtigen.

Verwendungszweck

Die DaTQUANT-Anwendung ermdglicht die visuelle
Beurteilung und Quantifizierung von '2I-loflupan
(DaTscan™)-Bildern. Dabei sorgt die DaTQUANT ,Normal
Database” (Normdatenbank) fiir die Quantifizierung im
Verhaltnis zu Normalpopulationsdatenbanken von 23]-
loflupan (DaTscan™)-Bildern. Sie hilft bei der Erkennung
des Funktionsverlusts von dopaminergen Neuronenenden
im Striatum, der mit Morbus Parkinson einhergeht.

Elektronische Anwendungsinformation
F=——N\

Im Lieferumfang dieser Software ist ein Bedienerhandbuch
in Form einer electronic Information for Use (elFU)
(Elektronische Anwendungsinformation [elFU]) enthalten.
Dies wird auf dem Etikett der Software durch das oben
abgebildete Symbol ausgewiesen.

Auf das Bedienerhandbuch kann jederzeit Uber das Hilfe-
Mendi in der rechten oberen Ecke des
Anwendungsbildschirms zugegriffen werden.

Zum Herunterladen sowie zum Anzeigen bzw. Ausdrucken
der aktuellen Bedienerdokumentations-CD gehen Sie
folgendermalien vor:

1. Gehen Sie zu https://www.gehealthcare.com/
support/support-documentation-library.

2. Wahlen Sie den Link NM (Nuklearmedizin) aus der
Modalitatenliste. Dadurch 6ffnet sich eine neue Seite.

3. Wahlen Sie unter NM Products (NM-Produkte) das
Produkt NM DaTQUANT aus.

4. Wahlen Sie Manual Types: CD (Handbuchtyp: CD).

5. Klicken Sie auf [Search] ([Suchen]).

6. Wahlen Sie unter Download die
Benutzerdokumentations-CD in der entsprechenden
Sprache aus.

7. Klicken Sie auf [Download Selected Files]
([Ausgewahlte Dateien herunterladen]).

8. Lesen Sie die Angaben zum Copyright und klicken Sie
auf [ACCEPT] ([AKZEPTIEREN]).

9. Klicken Sie auf [Save] ([Speichern]) und wéhlen Sie
einen Speicherort zum Herunterladen aus.

10. Klicken Sie auf [Open Folder] ([Ordner &ffnen]) und
entzippen Sie die heruntergeladene Datei, um auf das
Material zuzugreifen.

Hinweis: Nur fiir EU-Lander

Falls nicht bereits im Lieferumfang des Systems enthalten,

kann die Druckversion des Bedienerhandbuchs kostenlos

bestellt werden. Senden Sie hierzu eine Anfrage an lhren

Vertriebs- oder Kundendienstberater. Ihre Bestellung wird

normalerweise innerhalb von 7 Tagen bearbeitet.

Diese Druckversion kann u. U. geringfiigig von der
elektronischen Version auf Inrem System abweichen.
Kontaktieren Sie im Bedarfsfall zur Klarung etwaiger Fragen
lhren &rtlichen GE-Kundendienstvertreter.

Symbol Beschreibung Symbol Beschreibung Symbol Beschreibung
Katalognummer Hersteller Die Bedienungsanleitung ist
Referenznummer d auch in elektronischer Form
=—== verfugbar.
Herstellungsdatum Informationen hierzu finden Sie | Rx Only VORSICHT: In den USA ist der
&I @ im Benutzerhandbuch. Verkauf dieses Systems nur
auf arztliche Anordnung
gestattet.
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INSTALLIPROTSEDUUR

Tarkvara tuleb installida arvutisse, mis vastab kindlasti
minimaalsetele nduetele.

Enne tarkvara installimist tutvuge pdhjalikult DaTQUANT
kasutaja installi- ja aktiveerimisjuhendi 2. peatlkiga. Kdik
kasutusjuhendid asuvad installeerimispaketi kaustas ,Help“
(Abi).

HOIATUS: sulgege enne installimise alustamist koik
rakendused.

Enne installimise alustamist soovitame kindlasti kdik olulised
andmed varundada.

Rakenduse installimine

Peale DaTQUANT paketi allalaadimist salvestage see oma
kdvakettale.

Kaivitage installeerimispakett ja jatkake paigaldamise
protseduuri Idpetamiseks vastavalt ekraanil kuvatavatele
juhistele.

Parast tarkvara installimist sooritage arvuti korduskaivitus.

Deinstalleerige rakendus vdi Insite Remote Service
Kogu rakenduse deinstalleerimiseks kaivitage
installeerimispakett ja valige Remove/Modify (Eemalda/
muuda) vdi kasutage slisteemi juhtpaneeli.

Litsentsi installeerimine

Jargige startmenui aktiveerimis- ja registreerimisvahendi
ekraanil kuvatavaid juhiseid.

Rakenduse kéivitamine

Rakenduse saate kaivitada startmenuist voi té6laual
paikneva otsetee kaudu.

Laadige installeerimispakett arvutisse voi
valismaluseadmele

Te saate GE klienditeeninduselt e-kirja,
mis sisaldab GE susteemi tunnust
(salvestage see teave)

2]

'

Kaivitage installeerija Windows 7 v&i 10
operatsioonislisteemiga arvutis.
Selleks on vajalikud administraatori

obigused.

Installeerimise 16pus taitke
registreerimisvorm ja kldpsake allosas
GE-le aktiveerimispalvega e-kirja
koostamiseks ja saatmiseks.

'

Uhe té6paeva jooksul saate
GE klienditeeninduselt e-kirja
aktiveerimisfailiga (salvestage see).

'

avage DaTQUANT aktiveerimisvorm,

fail.

Selleks on vajalikud administraatori igused.

-—p

Salvestage aktiveerimisfail arvuti kdvakettale,

kldpsake ,Browse” (Sirvi) ja valige salvestatud

'

Tehnilist ja rakendust puudutavat tuge
saate telefoni teel GE tddajal. Kui vajate
abi installeerimisel, voi muus olukorras,
tuleb teil esitada ka GE silisteemi tunnus.
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OHUTUS- JA OIGUSTEAVE

Unique Device Identifier (UDI) (Seadme ainulaadne
identifikaator (UDI))

UDI leiate rakensuse About ekraanilt, millele saab ligipaasu
jargmiselt:

Applications > About (Rakendused > Teave) / Help >
About (Abi > teave) / Start > DatQuant > Tools (Start >
DatQuant > To6riistad).

Dokumentatsioon

Rakenduse DaTQUANT efektiivse ja turvalise kasutamise
tagamiseks tutvuge enne kaivitamist kindlasti komplekti
kuuluvate kasutusjuhenditega. Kogu dokumentatsiooni
leiate oma installeerimispaketist.

Tagage alati dokumentatsiooni kattesaadavus. Kui
dokumentatsioon pole kattesaadav, ei tohi rakendust
DaTQUANT mingil juhul kasutada. Kui vajate abi, vtke
Uhendust GE esindajaga.

Kasutuseesmark

DaTQUANT rakendus véimaldab '23|-ioflupaaniga
(DaTscan™) kujutiste visuaalset hindamist ja
kvantifitseerimist. DaTQUANT-i suvand Normal Database
(Normaalne andmebaas) véimaldab '?l-ioflupaaniga
(DaTscan™) kujutiste kvantifitseerimist vastavalt
normaalsetele populatsiooni andmebaasidele. See
rakendus vdib aidata tuvastada funktsionaalsete
dopaminergiliste narvildpmete kadu juttkehas, mida on
seostatud Parkinsoni tdvega.

Elektrooniline kasutusteave

F=——N\

Seade tarnitakse koos kasutusjuhendiga, mis on esitatud

elektroonilise kasutusteabe (elFU) vormis. Seda naitab

tarkvara silt, millel on kujutatud Ulalolev ikoon.

Kasutusjuhendite komplekt on alati saadaval rakenduse

ekraani paremas ulenurgas oleva spikrimentl kaudu.

Uusima kasutusjuhendi-CD allalaadimiseks ja selle sisu

kuvamiseks voi printimiseks toimige jargmiselt.

1. Juurdepdds https://www.gehealthcare.com/
support/support-documentation-library

2. Valige modaalsuste loendist link NM

(nukleaarmeditsiin). Avaneb uus leht.

Valige jaotisest NM Products NM DaTQUANT-i toode.

Valige suvand Manual Types: CD.

Kldpsake nuppu [Search] ([Otsi]).

Jaotises Download (Allalaadimine) valige sobivas

keeles kasutusjuhendi CD.

7. Kildpsake nuppu [Download Selected Files] ([Laadi
valitud failid)].

8. Lugege autoridigusteavet ja kidpsake nuppu [ACCEPT]
([NGustu]).

9. Kildpsake nuppu [Save] ([Salvesta]) ja valige
allalaadimise koht.

10. Kldpsake nuppu [Open Folder] ([Ava kaust]) ja pakkige
allalaaditud fail lahti, et sisule juurde paaseda.

Markus. Ainult EL-i liikmesriikidele

Kui kasutusjuhendi paberkoopiat pole susteemiga kaasas,

saate selle tellida lisatasuta. Saatke vastav taotlus oma

miilgi- voi teeninduskeskuse esindajale. Teie taotlust

kasitletakse seitsme paeva jooksul.

Paberkoopia voib teie siisteemi elektroonilisest koopiast

veidi erineda. Vajadusel votke selgituste saamiseks

Uhendust kohaliku esindajaga.

R ol

Sildi ikoon | Kirjeldus Sildi ikoon | Kirjeldus Sildi ikoon | Kirjeldus
Katalooginumber Tootja Kasutusjuhendid on varustuses
Viitenumber d elektroonilises vormis
=
Tootmiskuupaev Vaadake kasutusjuhendit Rx Only ETTEVAATUST:
&I @ Foderaalseadused lubavad
kéesolevat seadet miilia voi
tellida ainult arstidel.
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PROCEDIMIENTO DE INSTALACION

La instalacion del software debe realizarse en un ordenador
que cumpla los requisitos minimos.

Lea atentamente el Capitulo 2 de la Guia de activacion e
instalacion para el usuario de DaTQUANT antes de instalar
el software. Podra encontrar todas las guias del usuario en
la carpeta "Help" (Ayuda) del paquete de instalacion.
ADVERTENCIA: Asegurese de cerrar todas las
aplicaciones antes de comenzar la instalacion.

Es muy recomendable que realice una copia de seguridad
de todos sus datos de valor antes de realizar la instalacion.
Instalacion de la aplicacion

Tras descargar el paquete DaTQUANT, guardelo en su
disco duro.

Ejecute el paquete de instalacién y siga las instrucciones
que se muestran en pantalla para completar el proceso de
instalacion.

Debera reiniciar el equipo para poder finalizar la instalacion
del software.

Desinstalacion de la aplicacion o del servicio remoto de
InSite

Para desinstalar toda la aplicacion, ejecute el paquete de
instalacién y seleccione Remove/Modify (Eliminar/Modificar)
o desinstalelo desde el panel de control del sistema.
Instalacion de la licencia

Siga las instrucciones en pantalla de la herramienta de
activacion y registro a la que accedera desde el menu de
inicio.

Inicio de la aplicacion

Puede iniciar la aplicaciéon desde el menu inicial o desde el
acceso directo del escritorio.

Descargue el paquete de instalacion en
el ordenador o en una unidad portatil

Recibira un correo electrénico del
@ servicio de atencion al cliente de GE que
== contendra su numero de pedido y el ID
de sistema de GE

(guarde esta informacion)

v

Ejecute el instalador en un ordenador con
Windows 7 o0 10.

Debera disponer de derechos de
administrador.

= Cuando termine la instalacion, rellene el
/ formulario de registro y haga clic en la
parte inferior para generar y enviar un
correo electronico a GE para solicitar la

activacion.

En un dia habil, recibira un correo
electrénico del servicio de atencion al

activacion (guardelo).

'

cliente de GE que contendra el archivo de

v

Podra acceder a un servicio telefénico de
asistencia técnica y para aplicaciones

~<&—P qurante el horario comercial de GE. Si

necesita asistencia durante la instalacion,
o en cualquier otro momento, debera
proporcionar su ID de sistema de GE.

Guarde el archivo de activacion en el disco duro
de su ordenador, abra el formulario de activacion
de DaTQUANT, haga clic en “Browse” (Examinar)
y seleccione el archivo guardado.

Debera disponer de derechos de administrador.
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INFORMACION SOBRE NORMATIVAS Y
SEGURIDAD

Unique Device Identifier (UDI) (Identificador de
dispositivo nico)

Puede encontrar el cédigo UDI en la pantalla About (Acerca
de) de la aplicacion, a la que podra acceder de las
siguientes formas:

Aplications (Aplicaciones)>About (Acerca de) /

Help (Ayuda) >About (Acerca de) / Start (Inicio)>
DaTQUANT >Tools (Herramientas).

Documentacion

Para garantizar un uso eficiente y seguro de DaTQUANT,
es esencial que lea las Guias del usuario que se
proporcionan antes de realizar cualquier accion. Toda la

documentacion esta disponible en el paquete de instalacion.

Asegurese de que la documentacion esté disponible en todo
momento. No utilice DaTQUANT bajo ninguna circunstancia
si la documentacion no esta disponible. Si necesita ayuda,
péngase en contacto con su representante de GE.

Indicaciones de uso

La aplicacion DaTQUANT permite la evaluacion y
cuantificacion visual de imagenes de 2l-ioflupano
(DaTscan™). La opcién Normal Database (Base de datos
normal) de DaTQUANT permite la cuantificacion relativa a
bases de datos de poblaciones normales de imagenes de
23|-joflupano (DaTscan™). Esta aplicacion puede ayudar en
la deteccion de la pérdida de terminales neuronales
dopaminérgicos funcionales en el cuerpo estriado, que se
relaciona con la enfermedad de Parkinson.

Informacién de uso electrénica
———\

Este software se acompafia de un juego de manuales del
operador suministrados como Informacion de uso
electronica (elFU, por sus siglas en inglés). Esto se indica
mediante una etiqueta en el software con el icono mostrado
mas arriba.

Se puede acceder al conjunto de manuales del operador en
cualquier momento desde el menu de ayuda de la esquina
superior derecha de la pantalla de la aplicacion.

Para descargar la ultima versién del CD con el juego de
manuales del operador y ver o imprimir su contenido:

1. Acceso https://www.gehealthcare.com/
support/support-documentation-library

2. Seleccione el vinculo NM (medicina nuclear) de la lista
de modalidades. Se abrird una pagina nueva.

3. En NM Products (Productos de MN), seleccione el
producto NM (MN) DaTQUANT.

4. Seleccione Manual Types: CD.

5. Haga clic en [Search] ([Buscar]).

6. En Download (Descarga), seleccione el CD del
operador en el idioma apropiado.

7. Haga clic en [Download Selected Files] ([Descargar
archivos seleccionados]).

8. Lea lainformacién de copyright y haga clic en
[ACCEPT] ([ACEPTAR]).

9. Haga clic en [Save] ([Guardar]) y seleccione la ruta
para la descarga.

10. Haga clic en [Open Folder] ([Abrir carpeta]) y
descomprima el archivo descargado para acceder al
material.

Nota: sélo para estados miembros de la UE

Si no se ha suministrado ya con el sistema, es posible

solicitar una copia impresa del juego de manuales del

operador sin coste adicional alguno. Envie su solicitud al
representante de ventas o del servicio técnico local. Su
solicitud deberia ser atendida en una semana.

El contenido de dicha copia impresa puede variar
ligeramente con respecto a la copia electrénica descargada
en su sistema. Si precisa cualquier aclaracién, péngase en
contacto con el representante local.

Icono de Descripcion Icono de Descripcion Icono de Descripcion
etiqueta etiqueta etiqueta
Numero de catalogo Fabricante Las instrucciones de uso se
Numero de referencia d suministran en formato
= electrénico

I:l Fecha de fabricacion @

Consulte el manual/folleto de Con
instrucciones

Precaucion: La venta de este
dispositivo esta sujeta a
prescripcion facultativa por la
legislacion federal.

prescripcion
médica
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ASENNUS

Ohjelmiston saa asentaa ainoastaan vahimmaisvaatimukset
tayttavaan tietokoneeseen.

Lue ennen ohjelmiston asennusta huolellisesti DaTQUANT-
Jérjestelmén kaytté-, asennus- ja aktivointioppaan luku 2.
Kaikki kayttdoppaat ovat asennuspaketin Help (Ohje)
-kansiossa.

VAKAVA VAROITUS: Sulje kaikki sovellukset ennen
asennuksen aloittamista.

Tarkeat tiedot on suositeltavaa varmuuskopioida ennen
asennusta.

Sovelluksen asentaminen

Kun olet ladannut DaTQUANT-paketin, tallenna se
kiintolevyllesi.

Suorita asennuspaketti ja asenna ohjelmisto naytén
ohjeiden mukaan.

Tietokone on kdynnistettava uudelleen ohjelmiston
asennuksen jalkeen.

Poista sovellus tai InSite-etdpalvelu

Poista koko sovellus suorittamalla asennuspaketti ja
valitsemalla Remove/Modify (Poista/Muuta). Voit poistaa
sovelluksen myds jarjestelman ohjauspaneelista.
Lisenssin asentaminen.

Noudata Start (Kaynnista) -valikosta avattavan aktivointi- ja
rekisterGintitydkalun nayttdohjeita.

Sovelluksen kdynnistaminen

Sovellus voidaan kaynnistda Start (Kaynnista) -valikosta tai
tyopoydan pikakuvakkeesta.

Lataa asennuspaketti tietokoneeseen tai
ulkoiseen tallennusvalineeseen.

Saat GE-asiakaspalvelusta sahkdpostitse
tilausnumerosi ja GE-jarjestelmatunnuksesi.
(Sailytd nama tiedot)

2]

v

Suorita asennusohjelma tietokoneessa,
jossa on Windows-versio 7 tai 10.
Tarvitset jérjestelménvalvojan oikeudet.

'

Tayta asennuksen paatyttya
rekisterdintilomake ja napsauta lomakkeen
alareunan linkkia. Sovellus lahettéda GE:lle
aktivointipyynndn sahkdpostitse.

'

Saat GE-asiakaspalvelusta yhden
arkipadivan kuluessa sahkopostitse
aktivointitiedoston (séilyta se)

'

Tallenna aktivointitiedosto tietokoneesi
kiintolevylle, avaa DaTQUANT-
aktivointilomake, valitse Browse (Selaa) ja
valitse tallentamasi tiedosto.

Tarvitset jérjestelménvalvojan oikeudet.

-—p

'

Tekninen tuki ja sovellustuki ovat
tavoitettavissa puhelimitse GE:n
toimiston aukioloaikoina. Jos tarvitset
tukea sovelluksen asennuksen aikana tai
milloin tahansa, sinun on annettava GE-
jarjestelmatunnuksesi.
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TURVALLISUUS- JA
SAADOSTENMUKAISUUSTIEDOT

Unique Device Identifier (UDI) (Yksildllinen laitetunnus
(UDI)

UDI-koodi on sovelluksen About (Tietoja) ndytdssa, johon
paasee seuraavilla tavoilla:

Applications (Sovellukset) >About (Tietoja) / Help (Ohje) >
About (Tietoja) / Start (Kaynnistd) > DaTQUANT >Tools
(Tyokalut).

Ohjemateriaalit

Mukana toimitetut kayttdoppaat on luettava huolellisesti
ennen DaTQUANT-sovelluksen kayton aloittamista. Nain
varmistetaan, etta sovelluksen kayttod on turvallista ja etta
sité voidaan kayttaa tehokkaasti. Asennuspaketti sisaltéa
kaikki ohjemateriaalit.

Pida ne helposti saatavilla. Jos ohjeita ei ole kaytettavissa,
DaTQUANT-sovellusta ei saa kayttaa. Saat tarvittaessa
lisétietoja GE-edustajalta.

Kayttoaiheet

DaTQUANT-sovelluksella voi arvioida '23l-loflupane
(DaTscan™) -kuvia silmé@maaraisesti ja kvantifioida niita.
DaTQUANT-sovelluksen Normaalitietokannalla voi tehda
kvantifioinnin suhteessa normaalivaeston 2-loflupane
(DaTscan™!) -kuvien tietokantoihin. Sovelluksen avulla
voidaan havaita Parkinsonin taudin yhteydessa ilmeneva
aivojuovion funktionaalisten dopaminergisten
hermopaatteiden vaheneminen.

Sédhkoiset kdyttoohjeet

F=——N\

Ohjelmiston mukana toimitetaan sahkoiset kayttdohjeet
(elFU). Tama ilmoitetaan ohjelmistossa edella nakyvalla
kuvakkeella.

Kayttdohjeita voi kayttaa sovellusnaytdn oikeasta
ylakulmasta avattavasta ohjevalikosta.

Uusimman kayttdopas-CD:n lataaminen ja sen sisallon
tarkasteleminen ja tulostaminen:

1. Avaanhttps://www.gehealthcare.com/
support/support-documentation-library

2. Valitse modaliteettiluettelosta NM (Nuclear Medicine) -
linkki. Linkki avautuu uudelle sivulle.

3. Valitse tuote NM DaTQUANT (DaTQUANT-
isotooppikuvaus) kohdasta NM Products
(Isotooppikuvaustuotteet).

4. Valitse Manual Types: CD.

5. \Valitse [Search] ([Haku]).

6. Valitse halutunkielinen kayttdopas-CD kohdasta
Download (Lataa).

7. \Valitse [Download Selected Files] ([Lataa valitut
tiedostot]).

8. Lue tekijanoikeuslausunto ja valitse [ACCEPT]
([Hyvéksy]).

9. Valitse [Save] ([Tallenna]) ja valitse latauksen
tallennuspolku.

10. Valitse [Open Folder] ([Avaa kansio]) ja pura ladattu
tiedosto, jotta voit kayttaa sita.

Huomautus: vain EU-jasenmaat

Jos kayttdoppaan paperiversiota ei toimiteta jarjestelman

mukana, sen voi tilata ilman lisdmaksua. Laheta pyynté

myynti- tai huoltoedustajalle. Pyyntdsi pitaisi kasitella 7
paivan kuluessa.

Paperiversio voi olla hiukan erilainen kuin jarjestelmassa
oleva sahkdinen versio. Tarvittaessa voit pyytaa lisatietoja
paikalliselta edustajalta.

©

Merkinndn | Kuvaus Merkinndn | Kuvaus Merkinnén | Kuvaus
kuvake kuvake kuvake
Tuotenumero Valmistaja Kayttéohjeet toimitetaan
Viitenumero d sahkoisessd muodossa
=
I:l Valmistuspaivamaara Katso kayttdopas/-ohjeet Rx Only VAROITUS: Yhdysvaltain

littovaltion laki rajoittaa tdman
laitteen myynnin tai kayton
laakareille tai laakarin
maaraamaan kayttoon.
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PROCEDURE D'INSTALLATION

L'installation du logiciel doit étre effectuée sur un ordinateur
qui répond aux exigences minimales.

Veuillez lire attentivement le chapitre 2 du Guide
d'installation et d'activation DaTQUANT avant d'installer le
logiciel. Tous les guides de I'utilisateur se trouvent dans le
dossier « Help » (« Aide ») du progiciel d'installation.
AVERTISSEMENT : veillez a fermer toutes les
applications avant de commencer l'installation.

Il est fortement recommandé de sauvegarder toutes les
données importantes avant de procéder a l'installation.
Installation de I'application

Une fois le progiciel DaTQUANT téléchargé, enregistrez-le
sur votre disque dur.

Exécutez le progiciel d'installation et suivez les instructions
a I'écran pour terminer la procédure d'installation.

Une fois l'installation du logiciel terminée, il est nécessaire
de redémarrer l'ordinateur.

Désinstallation de I'application ou du service distant
InSite

Pour désinstaller I'intégralité de I'application, exécutez le
progiciel d'installation et sélectionnez Remove/Modify
(Supprimer/Modifier). Vous pouvez également désinstaller
I'application a partir du panneau de configuration systéme.
Installation de la licence

Suivez les instructions apparaissant a I'écran dans I'outil
d'activation et d'enregistrement accessible a partir du menu
Start (Démarrer).

Lancement de I'application

L'application peut étre lancée a partir du menu Start
(Démarrer) ou du raccourci bureau.

Téléchargez le progiciel d'installation sur
I'ordinateur ou sur un lecteur portable

9

Vous recevrez un e-mail du service client
GE contenant votre numéro de
commande et le GE System ID (ID du
systéeme GE)

(conservez ces informations)

i)

'

ordinateur équipé de Windows 7 ou 10.
Vous devez disposer des Administrator
rights (droits d'administrateur).

A la fin de l'installation, remplissez le
Registration form (Formulaire

un e-mail de demande d'activation a GE.

'

Dans un délai d'un jour ouvrable, vous
recevrez un e-mail du service client GE
contenant le fichier d'activation

(enregistrez-le)

cliquez sur « Browse » (« Parcourir ») et
sélectionnez le fichier enregistré.

Vous devez disposer des Administrator rights

(droits d'administrateur).

Exécutez le programme d'installation sur un

-

d'enregistrement) et cliquez sur le lien situé
au bas du formulaire pour créer et envoyer

v

Une plateforme d'assistance technique et
logicielle est accessible par téléphone
durant les heures d'ouverture de GE. Si
vous contactez l'assistance au cours de
l'installation ou a un autre moment, vous
devrez fournir I'ID de votre systéme GE.

Enregistrez le fichier d'activation sur le disque dur
de l'ordinateur, ouvrez le DaTQUANT Activation
form (Formulaire d'activation DaTQUANT),
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INFORMATIONS RELATIVES A LA
SECURITE ET A LA REGLEMENTATION

Unique Device Identifier (UDI) (Identifiant unique de
périphérique)

Le code UDI (Unique Device Identifier) est indiqué dans la
fenétre About (A propos) de l'application, accessible via :
Applications >About (Applications > A propos) /

Help >About (Aide > A propos) / Start>DaTQUANT >
Tools (Démarrer > DaTQUANT > Outils).

Documentation

Pour garantir une utilisation sire et efficace de DaTQUANT,
il est essentiel de lire les Guides de I'utilisateur fournis avant
toute tentative de démarrage. Toute la documentation est
disponible dans votre progiciel d'installation.

Assurez-vous que votre documentation est disponible a tout
moment. Vous ne devez en aucun cas utiliser DaTQUANT
si la documentation n'est pas disponible. Si vous avez
besoin d'aide, veuillez contacter le représentant GE.

Indications d'utilisation

L'application DaTQUANT permet d'évaluer visuellement et
de quantifier des images (DaTscan™) contenant de
l'ioflupane ('l). DaTQUANT Normal Database (Base de
données normale DaTQUANT) permet la quantification, par
rapport aux bases de données de la population normale,
des images (DaTscan™) contenant de l'ioflupane ('2I).
Cette application peut aider a détecter la perte de
terminaisons neuronales dopaminergiques fonctionnelles du
striatum, corrélée a la maladie de Parkinson.

Information électronique a utiliser
F=——N\

Ce logiciel est fourni avec un ensemble de manuels de elFU
(manuels de I'opérateur au format électronique). Cela est
signalé par une étiquette présente sur le systéme et portant
l'icone ci-dessus.

L'ensemble des manuels de I'opérateur est accessible a tout
moment depuis le menu Aide dans I'angle supérieur droit de
I'écran de I'application.

Pour télécharger la toute derniére version CD du manuel de
I'opérateur, la visualiser ou en imprimer le contenu :

1. Accéder a https://www.gehealthcare.com/
support/support-documentation-library

2. Sélectionner NM (Nuclear Medicine) (MN [Médecine
nucléaire]) dans la liste des modalités. Une nouvelle
page s'ouvre.

3. Sous NM Products (Produits NM), sélectionner le
produit NM DaTQUANT.

4. Sélectionner Manual Types: CD (Types de manuels :
CD).

5. Cliquer sur [Search] ([Rechercher])

6. Sous Download (Télécharger), sélectionner le CD
opérateur de la langue appropriée.

7. Cliquer sur [Download Selected Files] ([Télécharger
les fichiers sélectionnés])

8. Lire le Copyright et cliquer sur [ACCEPT]
([ACCEPTER]).

9. Cliquer sur [Save] ([Enregistrer]) puis sélectionner
I'emplacement ou les fichiers doivent étre téléchargés.

10. Cliquer sur [Open Folder] ([Ouvrir dossier]) puis
dézipper le fichier téléchargé pour accéder a son
contenu.

Remarque a I'attention des pays membres de I'Union
européenne uniquement

Si I'ensemble des manuels de I'opérateur n'a pas déja été
fourni avec le systeme, une version papier de celui-ci peut
étre commandée gratuitement. Pour cela, envoyez une
requéte au service technique ou commercial. Votre requéte
sera traitée sous 7 jours.

Cette version papier peut étre [égérement différente de la
version électronique présente sur votre systéme. Si
nécessaire, contactez votre représentant local pour obtenir
plus d'explications.

I:l Date de fabrication @

Icone de Description Icone de Description Icone de Description
I'étiquette I'étiquette I'étiquette
Références catalogue Fabricant Les instructions d'utilisation
Numéro de référence d sont fournies au format
=\ électronique

Reportez-vous au livret/manuel | Rx
d'instructions

MISE EN GARDE : d'aprés la
législation américaine, ce
dispositif ne doit étre vendu
qu'a un médecin ou sur l'ordre
d'un médecin.

uniquement
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mAnpo@opiwv Xpnotn Tou DaTQUANT
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EAAnVIKG

AIAAIKAZIA EFTKATAXTAZHY EKTEAEOTE TO TIAKETO EYKATAOTAGNG KAl GUVEXIOTE WE TIG
odnyieg €11 TNG 086vVNG yia va oAokAnpwaoeTe T diadikaagia

H eykataoTaon AoyIopIKOU TIPETTEl VO EKTEAEITAI HOVO O€ EYKQATAOTAONC,

uTTOAOYIOTH TTOU TTANPOI TIG EAAXIOTEG ATTAITAOEIG. i i . i
MNa va ohokAnpw6ei n eykardoTaon AoyiouIKoU, aTraiTeiTal

Mpiv amé TNV eykatdoTtaon AoyiopikoU SIaBAOTE TTPOCEKTIKA £TTAVEKKIVOT TOU UTIOAOYIGTH.

10 KepdAaio 2 Tou OdnyoU xprong yia Tnv eyKaraoraon Kai

evepyorroinan tou DaTQUANT. OAol ol 0dnyoi xpriong AWEVK?W‘""\UTF TNV EQAPHOYN N} TNV ATTOHAKPUOHEVN
BpiokovTal 0TO TTAKETO EYKATACTOONG OTO QAKeAO "Help" utrooTipign InSite
(BonBeia). Ma va atreykaTaoTAoETE OAOKANPN TNV £EQAPUOYN EKTEAEDTTE

MPOEIAOMOIHEH: BeBaiwbeite 6T éxeTe KAeioe GAegmig 10 TTAKETO EykatdoTaong kai emAegre Remove/Modify
E£QUPHOYES TTPIV GIT6 TNV EVaPEN TNG EYKATAOTAGNC, (Katépynon/Tpotromoinan) fi aTeyKaTacTAGTE T aTré Tov

ivaka eAEyxou Tou CUCTAPATOG.
ZuvioTaTal Idiaitepa n dnuioupyia eQedpIKoU avTypdpou Trvek ¥Xou Tou ougThuatos

OAWV TWV GNUAVTIKWY BEBOUEVWV TTPIV GUVEXITETE E TNV EykardoTtaon tng adeiag xprong
€yKATAoTOON. AkoAouBrioTe TIg 0dnyieg eTTi TNG 086vNG GTO £pyaAeio
EyKaTdoTaon TS EQAPHOYIC €VEPYOTTOINONG Kal £yypaPng Trou eival Siabéaipo atré 1o

O Start (E .
Metd Tn Aqywn Tou Takétou DaTQUANT, amoBnkelaTe 10 uevoy Start (Evapgn)

070 OKANPS Bioko oac. Ekkivnon Tng epappoyrig
MTropeiTe va EKKIVAOETE TNV e@appoyn atd 1o pevou Start
(Evapén) fi atmé Tn cuvTOpEUOn OTNV ETTIPAVEIN EPYOTIAG.

. MpaypartotroifoTe ARYN TOU TTOKETOU Qa AdBete éva e-mail ammod 1o TUAUa
£YKATAOTAONG OTOV UTTOAOYIOTH ) O€ @ €guUTTNPETNONG TTEAOTWV TN GE TTou Ba

v 3 @opnTr Yovada diokou —— TTEPIEXEI TOV apIBUO TNG TTapayyeAiag oag Kal

TO AVAYVWPICTIKG TOu ouaTrUaTog TG GE

(oTroBnKeUOTE AUTEG TIG TTANPOPOPIES)

' '

EkTeAéOTE TO TTPOYPAUUA EYKATACTAONG O€ AlatiBeTan TEXVIKR UTTOOTAPIEN Kal UTTOOTAPIEN
I utroAoyioTr) pe Windows exddoewv 7 i 10. E£QAPUOYWV HEOW TNAEPWVOU KaTE TIG
Amairoovrar dikaiwpara SlaxEipIoTh. <> epyaoiyeg wpeg Tng GE. Edv atmaiteital
s UTTOOTAPIEN KATG TNV eyKaTAOTOON | OE
OTTOIadNTTOTE XPOVIKN OTIYuR, Ba XpeIaoTEi va
TTAPEXETE TO AVAYVWPIOTIKO TOU CUCTAPOTOG
NG GE tou diabéTeTe.

2710 TEAOG TNG EYKATAGTOONG CUPTTANPWOTE
N @Opua Eyypaen kai Kavte KAIK 0TO KATW
HEPOG YIa VO BNUIOUPYAOETE Kal VO
amooTeileTe éva e-mail otnv GE tTou Ba
{nTd& TNV evepyoTToinon.

'

Evtég 1 epydoiung nuépag, Ba AdBeTe éva
e-mail atd To TPAPa eEUTTNPETNONG
o meAaTwyv TNg GE 110U Ba TTEPIEXEI TO apxEio

gvepyoTroinong (atmodnkeUoTe T0)

#

ATT0BnKEVOTE TO APXEIO EVEPYOTTOINONG OTO

‘v okAnpo BioKOo TOU UTTOAOYIOTH, QVOIgTE TN
@oOpyua evepyotroinong Tou DaTQUANT,
KavTe KAIk oTnv etmihoyn "Browse" (Mepiynon)
KaI ETTIAEETE TO ATTOONKEUPEVO apXEio.

Armairouvral Sikaiwpara SlaxeEIPIOTH.
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EAAnVIKG

NMAHPO®OPIEZ T'IA THN AZ®AAEIA KAI
PYOMIZTIKEZ [TNAHPO®OPIEZ

Movadiké avayvwpioTiké cuokeung (UDI)

Mrmropeite va Bpeite Tov kwdiké UDI atnv 086vn About
(MAnpoopieg), oTNV OTTOIa UTTOPEITE Va EXETE TTPOTRACN
HEOW TWV TTAPOKATW ETTIAOYWV:

Applications>About / Help>About /
Start>DaTQUANT>Tools (E@appoyég>TAnpogopieg/
BonBeia>TAnpogopies/Evapgn>DaTQUANT>EpyaAcia).
Tekunpiwon

MNa va d1a0@alicETe TNV ATTOTEAEOUATIKN KOI A0QAAr Xprion
Tou DaTQUANT, Ba mpétrel va SlaBAoeTe TOUG
TTapeXOUEVOUG 08NYoUg XProng TTpIV BOKINACETE va
gekiviioeTe. To aUvoAo TnG Tekunpiwong gival diaBéaipo
OTO TIOKETO EYKATAOTAGNG TTOU JIABETETE.

BeBaiwbeite 611 n Tekunpiwon gival diabéoiun ava maoa
oTiyunA. Agv Trpétrel va xpnoipotrolgite To DaTQUANT oe
Kapia TTePITITWanN, €av dev gival diaBéaiun n Tekpnpiwaon.
Edv xpeicleoTe BorBeiq, ETTIKOIVWVAOTE PE TOV
avTimpéowtro Tng GE.

‘Evdeig§n xpfiong

H epappoy DaTQUANT emiTpérer Tnv oTrTikr| agioAdynon
Kal TTO00TIKOTToiNoN €IKOVWY '22l-lopAouTraviou
(DaTscan™). H emAoyn Kavovikr Bdon dedopévwy Tou
DaTQUANT emTpéTTel TRV TTOCOTIKOTIOINGT O€ OX£ON PE
Kavovikég Baaelg Sedopévwy TTAnBuapoU TTou
mepIAapBavouy eikéveg 2l-lopAouTtaviou (DaTscan™). H
€QAPMOYN QUTA PTTOPEi va BonBroel GTnv avixveuon Tng
ATTWAEIAG AEITOUPYIKWY OTTOAAGEWY VTOTTAUIVEPYIKWY
VEUPWVWY 0TO paBdwTd owpa, n oTroia oxXeTieTal pe véoo
Mépkivoov.

HAekTpovikég mAnpogopiss xpiong
F=——N\

To mmapdv AoyiopIKé ouvodeUeTal aTTd éva GUVOAO
EYXEIPISIWV XEIPIOTH TTOU TTAPEXOVTAI O€ NAEKTPOVIKH HOP®R
wg eyxeIpidia odnyiwv xpAong (elFU). Autoé emonuaiveTal
atd TNV ETIKETA TTOU UTTAPXEI OTO AOYIOHIKO, OTNV OTToia
€M@aviICETal TO TTAPATTAVW EIKOVIBIO.

To oUvoAo eyxeIpIBiwv XEIPIOTH gival TTIPOGRACIPO avd TTaoa
oTiyuA a1md 1o pevol BoRBbeiag TTou BPioKkeTal OTNV ETTAVW
Seg1d ywvia TG 086vNng TNG EQAPUOYAG.

Ma Aqyn Tou Mo TTpdo@aTtou CD Tou gyxelpIdiou XeIPIOTH
Kl TTPOBOAR | EKTUTTWON TOU TTEPIEXOUEVOU TOU:

1. Mpoéofaon https://www.gehealthcare.com/
support/support-documentation-library

2. EmA£éETe Tn olvdeon NM (Mupnvikr 10TPIKA) atTd T
ANioTa Twv povadwy. Oa avoigel pia véa oehida.

3. Amo6 10 pevou NM Products (Mpoidvta NM), emAégTe TO
Trpoiév NM DaTQUANT (DaTQUANT trupnvikig
I0TPIKAG).

4. EmA&gTe Manual Types: CD.

5. MatAoTe [Search] (Avagitnon).

6. Kdtw amoé v emAoyr) Download (Afqyn), emAEETE TO
CD xelpioTr) TNV KatdAAnAn yAwooa.

7. TMatAoTte [Download Selected Files] (Afyn
ETTIAEYPEVWV OPXEIWV).

8. AiaBdaoTe TIG ONAWOEIG TTEPT TIVEUPATIKWY JIKAIWHPATWY
kai atote [ACCEPT] (AMTOAOXH).

9. [MatoTe [Save] (AToBrikeuon) Kai TTIAEETE TN
Siadpopn yia amobrikeuon Tou AneBEvTog apxeiou.

10. MarAote [Open Folder] (Avolypa gakéAou) Kal
OTTOOUPTTIEOTE TO AN@POEV apxEio yIa va avoiteTe TO
UAIKO.

Znpeiwon: Mévo yia kpdrn-péAn Tng EE

Edv dev d1aBéteTe 0N TNV EVIUTIN MOP@I TOU gyXelpIdiou

XEIPIOTA TTOU TTAPEXETAI ME TO OUCTNHA, PTTOPEITE VO

TTapayyeiAeTe £va avTiypa@o xwpig TTpOaBeTn xpéwon.

2T€IATE TO QITNNE 0OG O€ évav EKTTPOCWTTO TOU TUANATOG

TIWAACEWV 1) TOU TUAPATOG TEXVIKAG uTTooTHPIENG. H

€TTEgEPYaAaTia Tou AITAPATOG 0OG avVOUEVETAl VO OAOKANPwWOET

EVTOG 7 NUEPWV.

To €vTuTro avTiypa@o evOEXETAI VO SIQPEPEI EAAPPWG ATTO TO

NAEKTPOVIKO QVTiypago TTou UTTapxEl 0To ouoTnud oag. Edv

XPEIGLEOTE TTEPITOOTEPEG TTANPOPOPIEG, ETTIKOIVWVHOTE PE

TOV TOTTIKO QVTITIPOCOWTTO.

Eikovibio Mepiypaen Eikovidio Meprypaen Eikovidio Mepiypaen
ETIKETOG ETIKETAG ETIKETOG
ApIBu6G kaTaAdyou KataokeuaoTrig O1 0dnyieg xpriong TrapéxovTal
ApIB6G avapopdg d € NAEKTPOVIKA HOPPn
=
Huepopnvia kataokeung AvaTpégTe oTo eyXelpidio/ Rx Only MPOZOXH: H opooTrovdiakn
& @ @UAAGDIO 0BNYIWV vopoBeaia EMITPETEI TNV
TIWANON AUTAG TNG CUOKEUAG
pévo aTré 1a1pols A KATOTTIV
€VTOAAG 10TPOU.
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POSTUPAK INSTALACIJE

Instalacija softvera mora se izvrsiti na raéunalu koje
ispunjava minimalne zahtjeve.

Pazljivo procitajte 2. poglavlje korisnickog prirucnika za
instalaciju i aktivaciju DaTQUANT prije instalacije softvera.
Svi se korisnicki priruénici nalaze u instalacijskom paketu u
mapi “Help” (Pomo¢).

UPOZORENJE: Zatvorite sve aplikacije prije pocetka
instalacije.

Preporucuje se da prije instalacije izradite sigurnosnu kopiju
svih vrijednih podataka.

Instalacija aplikacije

Nakon preuzimanja paketa DaTQUANT spremite ga na tvrdi
disk.

Pokrenite instalacijski paket i slijedite upute na zaslonu kako
biste dovrsili instalaciju.

Nakon zavrSetka instalacije softvera potrebno je ponovno
pokrenuti ra¢unalo.

Deinstaliranje aplikacije ili usluge InSite Remote Service
Za deinstaliranje kompletne aplikacije pokrenite instalacijski
paket i odaberite Remove/Modify (Ukloni/Promijeni) ili
deinstalirajte putem upravljacke plo¢e sustava.

Instaliranje licence

Slijedite upute na zaslonu u alatu za aktivaciju i registraciju
koji je dostupan na izborniku Start.

Pokretanje aplikacije

Aplikacija se moze pokrenuti s izbornika Start ili pre€aca na
radnoj povrsini.

Preuzmite instalacijski paket na rac¢unalo
ili prijenosni uredaj

Primit éete poruku e-poste od korisni¢ke
sluzbe tvrtke GE u kojoj ¢e se nalaziti broj
vase narudzbe i va$ sistemski ID za GE.
(spremite te podatke)

2]

'

Pokrenite program za instalaciju na
racunalu sa sustavom Windows 7 ili 10.
Potrebno je imati administratorska prava.

#

Na kraju instalacije ispunite obrazac za
registraciju i pritisnite na dnu kako biste

zahtjevom za aktivaciju.

'

Unutar 1 radnog dana primit ¢ete poruku e-

poste od korisni¢ke sluzbe tvrtke GE u
kojoj ¢e se nalaziti datoteka za aktivaciju

(spremite je)

racunala, otvorite aktivacijski obrazac za

odaberite spremljenu datoteku.
Potrebno je imati administratorska prava.

-—p

generirali i GE-u poslali poruku e-poste sa

Spremite aktivacijsku datoteku na tvrdi disk

v

Tehni¢ka podrska i podrska za aplikacije
dostupna je telefonski tijekom radnog
vremena tvrtke GE. Ako ¢ete tijekom
instalacije ili u bilo koje drugo vrijeme
trebati podrsku, trebat ¢ete dati svoj
sistemski ID za GE.

DaTQUANT, pritisnite “Browse” (Pretrazivanje) i
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SIGURNOSNA PRAVILA

Unique Device Identifier (UDI) (Jedinstveni identifikator
uredaja (UDI))

UDI $ifra nalazi se na zaslonu About (O) u aplikaciji kojem
mozete pristupiti na sljede¢e nacine:

Applications (Aplikacije) >About (O) / Help (Pomo¢) >
About (O) / Start>DaTQUANT >Tools (Alati).

Dokumentacija

Za ucinkovito i sigurno koriStenje aplikacije DaTQUANT
nuzno je procitati korisni¢ke priruénike prije pokretanja.
Kompletna dokumentacija dostupna je u vasem
instalacijskom paketu.

Uvijek drzite dokumentaciju pri ruci. Ni u kojem slu€aju
nemojte koristiti aplikaciju DaTQUANT ako dokumentacija
nije dostupna. Ako trebate pomoc¢, obratite se predstavniku
tvrtke GE.

Indikacije za upotrebu

Aplikacija DaTQUANT omogucuje vizualnu evaluaciju i
kvantifikaciju ?*l-ioflupan (DaTscan™) slika. DaTQUANT
Normal Database omogucuje kvantifikaciju u odnosu na
baze referentnih vrijednosti populacije '23l-ioflupan
(DaTscan™) slika. Ova aplikacija moze pomoci u otkrivanju
gubitka funkcija terminala dopaminergi¢nih neurona u
striatumu koje uzrokuje Parkinsonova bolest.

- Elektronicke upute za koristenje
F=———\

Softver se isporucuje s kompletom korisnickih priru¢nika u
obliku elektronskih uputa za koristenje (elFU). Na to vas
upucuje oznaka u softveru na kojoj se nalazi gore prikazana
ikona.

Kompletu korisni¢kih priru¢nika moZzete pristupiti u svakom

trenutku iz izbornika pomo¢i u gornjem desnom kutu

zaslona aplikacije.

Za preuzimanje najnovijeg CD-a korisnickog priru¢nika i

prikaz ili ispis njegovog sadrzaja:

1. Otvorite stranicu https://
www.gehealthcare.com/support/support-
documentation-library

2. Odaberite vezu NM (Nuclear Medicine) na popisu
modaliteta. Otvorit ¢e se nova stranica.

3. Odaberite proizvod NM DaTQUANT s popisa NM
Products (NM proizvodi).

4. Odaberite Manual Types: CD (Rucne vrste: CD).

5. Pritisnite [Search] (Pretrazi).

6. Iz podru¢ja Download (Preuzimanje) odaberite CD
korisni¢kog priru¢nika na odgovaraju¢em jeziku.

7. Pritisnite [Download Selected Files] (Preuzmi
odabrane datoteke).

8. Procitajte podatke o autorskim pravima i pritisnite
[ACCEPT] (Prihvati).

9. Pritisnite [Save] (Spremi) i odaberite put za
preuzimanje.

10. Pritisnite [Open Folder] (Otvori mapu) i raspakirajte
preuzetu datoteku kako biste pristupili njenom sadrzaju.

Napomena: Samo za drzave ¢lanice Europske unije.

Ako nije isporucen uz sustav, papirnati primjerak korisnickog

priru¢nika mozete besplatno naruciti. Posaljite zahtjev

predstavniku za prodaju ili servis. Va$ ¢e zahtjev biti
obraden u roku od 7 dana.

Moguce su manje razlike izmedu papirnatog primjerka i

elektronske kopije na vaSem sustavu. Ako su vam potrebna

pojasnjenja, obratite se lokalnom predstavniku.

Ikona na Opis Ikona na Opis lkona na Opis
oznaci oznaci oznaci

Katalo$ki broj Proizvodac¢ Upute za upotrebu isporuéuju
Referentni broj d se u elektroni¢kom obliku

=

Datum proizvodnje Pogledajte korisnicki prirucnik/ | Rx Only OPREZ: Zakon SAD-a dopusta

& @ knjizicu prodaju ovog uredaja samo od
strane ili po nalogu lije¢nika.
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PROCEDURA DI INSTALLAZIONE

L'installazione del software deve essere eseguita
esclusivamente su computer che soddisfano i requisiti
minimi.

Prima dell'installazione del software, leggere attentamente il
capitolo 2 della Guida dell'utente per l'installazione e
l'attivazione di DaTQUANT. Tutte le guide dell'utente sono
disponibili nel pacchetto di installazione nella cartella "Help'
(Guida).

AVVERTENZA: assicurarsi di chiudere tutte le
applicazioni prima di iniziare I'installazione.

Si consiglia vivamente di eseguire un backup di tutti i dati
importanti prima di procedere all'installazione.

Installazione dell'applicazione

Dopo aver scaricato il pacchetto DaTQUANT, salvarlo sul
disco.

Eseguire il pacchetto di installazione e proseguire
attenendosi alle istruzioni visualizzate sullo schermo per
completare la procedura di installazione.

L'installazione del software richiede il riavvio del computer al
termine della procedura.

Disinstallazione dell'applicazione o dell'assistenza in
remoto InSite

Per disinstallare l'intera applicazione, eseguire il pacchetto
di installazione e scegliere Remove/Modify (Rimuovi/
Moadifica) o disinstallarla dal pannello di controllo del
sistema.

Installazione della licenza

Seguire le istruzioni visualizzate sullo schermo nello
strumento di attivazione e registrazione disponibile nel
menu Start (Avvio).

Avvio dell'applicazione

L'applicazione puo essere avviata dal menu Start (Avvio) o
dal collegamento sul desktop.

Scaricare il pacchetto di installazione sul
computer o su un'unita portatile

Ricevera un'e-mail dall'assistenza clienti
GE contenente il numero dell'ordine e I''D
sistema GE

(salvare queste informazioni)

2]

'

versione di Windows 7 o 10.
Sono necessari i diritti di Amministratore.

'

Al termine dell'installazione, completare il
modulo di registrazione e fare clic sul link
nella parte inferiore per creare e inviare

#

Entro 1 giorno lavorativo ricevera un'e-mail
dall'assistenza clienti GE contenente il file

di attivazione (da salvare).

#

selezionare il file salvato.
Sono necessari i diritti di Amministratore.

Eseguire l'installazione su un computer con

-

un'e-mail a GE per richiedere 'attivazione.

'

L'assistenza tecnica e delle applicazioni &
disponibile telefonicamente durante I'orario
lavorativo di GE. Il proprio ID sistema GE
deve essere fornito se si richiede assistenza
durante l'installazione o in qualunque altro
momento.

Salvare il file di attivazione sul disco rigido del
computer, aprire il modulo di attivazione di
DaTQUANT, fare clic su "Browse" (Sfoglia) e
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INFORMAZIONI NORMATIVE E SULLA
SICUREZZA

Unique Device Identifier (UDI), (Identificatore univoco
del dispositivo, UDI)

Il codice UDI e riportato nella schermata dell'applicazione
About (Informazioni su), accessibile tramite uno dei
seguenti percorsi:

Applications (Applicazioni) > About (Informazioni su) /
Help (Guida) > About (Informazioni su) / Start (Avvio) >
DaTQUANT > Tools (Strumenti).

Documentazione

Per garantire un utilizzo efficiente e sicuro di DaTQUANT, &
fondamentale leggere le guide dell'utente fornite prima di
iniziare. L'intera documentazione & disponibile nel pacchetto
di installazione.

Assicurarsi che la documentazione sia sempre prontamente
disponibile. Se la documentazione non ¢ disponibile, non
utilizzare DaTQUANT in alcun caso. Per richiedere
assistenza, contattare il rappresentante GE.

Indicazioni per I'utilizzo

L'applicazione DaTQUANT consente la valutazione e la
quantificazione visive delle immagini ioflupane %I
(DaTscan™). Il database normale di DaTQUANT consente
la quantificazione rispetto ai database della popolazione
normale di immagini ioflupane '2°l (DaTscan™). Questa
applicazione puo essere utile nella rilevazione di perdita di
terminali dei neuroni dopaminergici funzionali nel corpo
striato, che & correlata al morbo di Parkinson.

Informazioni per I'uso in formato
F=——N\

elettronico

Il presente software viene fornito con una raccolta di
manuali per I'operatore sotto forma di informazioni per I'uso
in formato elettronico (elFU). Tale opzione €& indicata
dall'etichetta nel software e riportante I'icona visualizzata
sopra.

La raccolta di manuali per l'operatore & accessibile in
qualsiasi momento dal menu della guida nell'angolo
superiore destro della schermata dell'applicazione.

Per accedere al CD contenente i manuali operatore piu
aggiornati e visualizzarne o stamparne il contenuto:

1. Accedere a https://www.gehealthcare.com/
support/support-documentation-library

2. Selezionare il collegamento NM (medicina nucleare)
nell'elenco delle modalita. Viene aperta una nuova
pagina.

3. In NM Products (Prodotti NM), selezionare il
prodotto NM DaTQUANT.

4. Selezionare Manual Types: CD.

5. Fare clic su [Search] [Cercal].

6. In Download (Scarica), selezionare il CD contenente i
manuali operatore nella lingua desiderata.

7. Fare clic su [Download Selected Files] [Scarica file
selezionati].

8. Leggere il Copyright, quindi fare clic su [ACCEPT]
[ACCETTA].

9. Fare clic su [Save] [Salva], quindi selezionare il
percorso da cui scaricare il file.

10. Fare clic su [Open Folder] [Apri cartella], quindi
decomprimere il file scaricato per accedere al
contenuto.

Nota: solo per gli Stati membri dell'UE

E possibile ordinare una copia cartacea dei manuali, se non
fornita con il sistema, senza alcun costo aggiuntivo. Inviare
I'ordine al rappresentante dell'assistenza o di vendita. La
richiesta verra evasa entro 7 giorni.

La copia cartacea pud contenere piccole variazioni rispetto
alla copia elettronica. Se necessario, contattare il
rappresentante di zona per chiarimenti.

Icona Descrizione Icona Descrizione Icona Descrizione
dell'etichetta dell'etichetta dell'etichetta
Numero di catalogo Produttore Le Istruzioni per I'uso sono
Numero di riferimento d fornite in formato elettronico
=
Data di produzione Consultare il manuale o Rx Only ATTENZIONE: La legge
&I @ I'opuscolo delle istruzioni federale degli Stati Uniti

consente la vendita del
dispositivo solo dietro
prescrizione medica.
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A TELEPITES MENETE
A szoftvert csak olyan szamitégépre lehet telepiteni, amely
megfelel a minimalis rendszerkdvetelményeknek.

Kérjlk, olvassa el alaposan a DaTQUANT telepitési és
aktivalasi tmutato 2. fejezetét, miel6tt hozzalatna a szoftver
telepitéséhez. Minden utmutaté a telepitécsomag ,Help”
(Sugd) mappajaban talalhato.

FIGYELMEZTETES: A telepités megkezdése elétt zarjon
be minden alkalmazast.

A telepités el6tt javasolt biztonsagi mentést késziteni a
fontos adatokrol.

Az alkalmazas telepitése

Mentse le a merevlemezre a DaTQUANT csomagot.

Inditsa el a telepitécsomagot, és kdvesse a képernyén
megjelend utasitasokat a telepitési eljaras elvégzéséhez.
A telepités véglegesitéséhez ujra kell inditani a
szamitogépet.

Az alkalmazas és az InSite Remote Service eltavolitasa
A teljes alkalmazas eltavolitasahoz inditsa el a
telepitécsomagot, és a rendszer vezérlpultjan valassza a
Remove/Modify (Eltavolitds/Modositas) lehetdséget.

A licenc telepitése

Kdvesse a Start meniibdl elérhetd aktivacios és
regisztracios eszkoz altal megjelenitett utasitasokat.

Az alkalmazas elinditasa

Az alkalmazast a Start meniibél vagy az asztalon Iévé
parancsikonnal lehet elinditani.

Toltse le a telepitécsomagot
szamitogépre vagy egy cserélhetd

Kapni fog egy e-mailt a GE Customer
Service-t6l, mely a rendelési szamot és a
GE System ID-t (GE rendszer
azonositéja) tartalmazza

(ezeket az adatokat 6rizze meg)

2]

adathordozéra

Inditsa el a telepitét Windows 7 vagy 10

szlikséges.

#

A telepités végén toltse ki a regisztracios
rlapot, majd kattintson a lap aljan lévé
gombra az aktivacios igény GE szamara
torténd elkildéséhez.

'

Egy munkanapon belll kapni fog egy
e-mailt a GE Customer Service-tél, mely

el)

'

Mentse le az aktivacios fajlt szamitégépe

operacios rendszert futtaté szamitégépen.
A miivelethez rendszergazdai jogosultsag <>

tartalmazza az aktivacios fajlt (ezt mentse

'

A GE telefonos ugyfélszolgalata
munkaidében all rendelkezésre. Ha
segitségre van sziiksége a telepitéssel
vagy barmi massal kapcsolatban, meg
kell adnia a GE rendszer azonositéjat.

merevlemezére, nyissa meg a DaTQUANT
aktivacios Urlapot, kattintson a ,Browse” (Tallézas)
gombra, majd valassza ki a lementett fajlt.

A miivelethez rendszergazdai jogosultsag
szlikséges.
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BIZTONSAGI ES SZABALYOZASI
INFORMACIOK

Unique Device Identifier (UDI) (Egyedi eszk6zazonosito)

Az UDI-kéd az alkalmazas About (Névjegy) képernydjén
tekinthet6 meg, amit az alabbiak szerint lehet elérni:
Alkalmazasok >About (Névjegy)/ Help >About (Névjegy)
/ Start>DaTQUANT >Tools (Eszkdzok).

Dokumentaciok

A DaTQUANT hatékony és biztonsagos hasznalata
érdekében elengedhetetlen, hogy a szoftver hasznalata elétt
elolvassa a mellékelt Kezeldi utmutatdkat. Minden
dokumentacié megtalalhaté a telepitécsomagban.

Gondoskodjon réla, hogy a dokumentaciok mindig
elérhetbek legyenek. Ne hasznalja a DaTQUANT rendszert,
ha a dokumentacié nem all rendelkezésre. Ha segitségre
van sziiksége, forduljon a GE munkatarsaihoz.

Hasznalati javallat

A DaTQUANT alkalmazas '?I-joflupan (DaTscan™) képek
vizualis kiértékelését és kvantifikalasat teszi lehetévé. A
DaTQUANT Normal Database (normal adatbazis) lehetévé
teszi a normal populacidk esetén rogzitett '23I-joflupan
(DaTscan™) képekhez viszonyitott kvantifikalast. Ez az
alkalmazas segithet a miikdd6képes dopaminerg
idegvégzddések elvesztésének észlelésében a striatum
tertletén, ami 6sszefliggést mutat a Parkinson-kérral.

Elektronikus hasznalati utmutatoé
F=——N\

Az ehhez a szoftverhez tartozé felhasznaloi
kézikdnyvcsomag elektronikus hasznalati Gtmutaté
formajaban all rendelkezésre. Ezt a fenti ikon jelzi a
szoftverben.

A felhasznaldi kézikdnyvcsomag barmikor elérheté az
alkalmazas jobb felsé sarkaban 1évé sugé menibél.

A leguUjabb felhasznaldi kézikdnyv CD-jének letoltése és
tartalmanak megtekintése vagy kinyomtatasa:

1. Elérési ut: https://www.gehealthcare.com/
support/support-documentation-library

2. A modalitasok listajabdl valassza az NM (nuklearis
medicina) hivatkozast. Ekkor megnyilik egy Uj oldal.

3. Az NM Products (NM termékek) meniiben valassza ki
az NM DaTQUANT terméket.

4. Valassza ki a Manual Types: CD (Manualis tipusok:
CD) opciot.

5. Kattintson a [Search] ([Keresés])gombra.

6. A Download (Letdltés) listdban valassza ki a megfelelé
nyelvi felhasznaldi CD-t.

7. Kattintson a [Download Selected Files] ([Kijelolt fajlok
letoltése]) gombra.

8. Olvassa el a szerz6i jogokrol sz6l6 nyilatkozatot, és
kattintson az [ACCEPT] ([Elfogadom]) gombra.

9. Kattintson a [Save] ([Mentés]) gombra, és valassza ki a
letoltési utvonalat.

10. Kattintson az [Open Folder] ((Mappa megnyitasa])
gombra, és csomagolja ki a letoltétt fajlt, hogy
hozzaférhessen a kézikdnyvhoz.

Megjegyzés: Kizarélag EU-tagallamok szamara

Ha a felhasznaldi kézikényv csomag nem volt mellékelve az

eszkdzhdz, ingyen megrendelheti annak nyomtatott

valtozatat. Kuldje el igénylését értékesitési vagy
szervizképvisel6jének. Kérését 7 napon belil feldolgozzak.

A nyomtatott példany eltérhet az eszk6zon elérhetd

elektronikus valtozattdl. Ha sziikséges, tovabbi

tajékoztatasért forduljon a helyi képvisel6hodz.

Cimkeikon | Leiras Cimkeikon | Leiras Cimkeikon | Leiras
Katalogusszam Gyarto A hasznalati utmutaté
Referenciaszam d elektronikus formaban all
= rendelkezésre
I:l A gyartas datuma Lasd a hasznalati utasitast Rx Only FIGYELEM: Az Amerikai

©

Egyesiilt Allamok szévetségi
térvényeinek értelmében ez az
eszkdz kizarolag orvos altal
vagy orvosi rendelvényre
értékesithetd.
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loflupane ("?3])-beeldvorming
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WAARSCHUWING:
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Nederlands

INSTALLATIEPROCEDURE

De software mag alleen worden geinstalleerd op een
computer die voldoet aan de minimale vereisten.

Lees hoofdstuk 2 van de Gebruikershandleiding voor
installatie en activering van DaTQUANT zorgvuldig
voorafgaand aan installatie van de software. Alle
gebruikershandleidingen bevinden zich in het
installatiepakket in de map Help.

WAARSCHUWING: Sluit alle toepassingen voordat de
installatie wordt gestart.

Het wordt ten zeerste aangeraden om een back-up te
maken van alle belangrijke gegevens voordat de installatie
wordt voortgezet.

Installeer de toepassing

Sla het DaTQUANT-pakket na het downloaden op uw harde
schijf op.

Open het installatiepakket en volg de instructies op het
scherm om de installatieprocedure te voltooien.

Na de installatie van de software moet de computer opnieuw
worden opgestart.

Verwijder de toepassing of InSite Remote Service

Open het installatiepakket en kies Remove/Modify
(Verwijderen/Wijzigen) om de gehele toepassing te
verwijderen of doe dit vanuit het onderdeel Systeem van het
Configuratiescherm.

Installeer de licentie

Volg de scherminstructies van het hulpmiddel voor
activering en registratie, beschikbaar via het startmenu.

De toepassing starten

De toepassing kan worden gestart via het startmenu of via
de snelkoppeling op het bureaublad.

Download het installatiepakket naar een

J computer of draagbare schijf

U ontvangt een e-mail van de GE-
@ klantenservice met daarin uw
== bestelnummer en GE-systeem-ID
(sla deze informatie op)

'

Open het installatieprogramma op een
I computer die draait op Windows 7 of 10.

Administratorrechten zijn vereist.

'

~W Vul aan het einde van de installatie het
@ registratieformulier in en klik onderaan om
& =

een e-mail met een activatieverzoek te
genereren en naar GE te verzenden.

'

U ontvangt binnen 1 werkdag een e-mail

van de GE-klantenservice met daarin het
— activatiebestand (sla dit op)

v

Sla het activatiebestand op een computer of
harde schijf op, open het DaTQUANT-
activatieformulier, klik op Browse (Bladeren)
en selecteer het opgeslagen bestand.

Administratorrechten zijn vereist.

v

Technische ondersteuning en
ondersteuning voor toepassingen is per
telefoon beschikbaar tijdens de
kantooruren van GE. U dient uw GE-
systeem-ID op te geven wanneer er
tijdens de installatie of op een andere tijd
ondersteuning nodig is.

42



Nederlands

VEILIGHEIDS- EN
REGELGEVINGSINFORMATIE

Unique Device Identifier (UDI) (Unieke
apparaatidentificatie (UDI))

De UDI-code kan worden gevonden in het scherm About
(Over) van de toepassing. Dit scherm is op de volgende
manieren toegankelijk:

Applications>About / Help>About / Start>DaTQUANT>
Tools (Toepassingen > Over > Help > Over/Start >
DaTQUANT > Hulpmiddelen).

Documentatie

Het is essentieel dat u de gebruikershandleidingen leest

voordat u DaTQUANT start, voor een efficiénte en veilige
werking. De volledige documentatie is beschikbaar in uw
installatiepakket.

Zorg ervoor dat de documentatie altijd bij de hand is.
DaTQUANT mag in geen geval worden gebruikt als de
documentatie niet beschikbaar is. Neem contact op met de
GE-vertegenwoordiger als u hulp nodig hebt.

Gebruiksindicatie

De DaTQUANT-toepassing maakt visuele beoordeling en
kwantificatie van '#I-joflupaan (DaTscan™)-beelden
mogelijk. De DaTQUANT Normal Database (normale
database) maakt kwantificatie ten aanzien van normale
populatie-databases met 'I-joflupaan (DaTscan™)-
beelden mogelijk. Deze toepassing kan helpen bij de
detectie van verlies van functionele dopaminerge
zenuwuiteinden in het striatum, hetgeen een correlatie heeft
met de Ziekte van Parkinson.

Elektronische gebruiksinformatie
F=———\

Deze software wordt geleverd met een set
bedieningshandleidingen die beschikbaar zijn als
elektronische gebruiksinformatie (elFU). Dit wordt door
middel van het bovenstaande pictogram aangegeven op het
label in de software.

Het bedieningshandleidingpakket is altijd bereikbaar via het
helpmenu in de rechterbovenhoek van het
toepassingsscherm.

U kunt de inhoud van de meest recente cd met
bedieningshandleiding als volgt bekijken of afdrukken:

1. Ganaar https://www.gehealthcare.com/
support/support-documentation-library

2. Selecteer de koppeling NM (Nuclear Medicine -
Nucleaire geneeskunde) uit de modaliteitenlijst.
Er wordt een nieuwe pagina geopend.

3. Selecteer bij NM Products ([NM-producten]) het NM
DaTQUANT-product.

4. Selecteer Manual Types: CD (Type handleiding: cd).
5. Klik op [Search] ([Zoeken]).

6. Selecteer onder Download ([Downloaden]) de cd voor
gebruikers in de gewenste taal.

7. Klik op [Download Selected Files] ([Geselecteerde
bestanden downloaden]).

Lees de copyrightinformatie en klik op [ACCEPT]
([ACCEPTEREN]).

9. Klik op [Save] ([Opslaan]) en selecteer het pad voor de
download.

10. Klik op [Open Folder] ([Folder openen]) en pak het
gedownloade bestand uit om het materiaal te openen.

Opmerking: alleen voor lidstaten van de EU

Als er geen papieren versie van de set
bedieningshandleidingen met het systeem meegeleverd,
kan deze zonder bijkomende kosten worden aangevraagd.
Stuur uw aanvraag naar uw verkoopvertegenwoordiger of
onderhoudsmedewerker. Uw aanvraag wordt normaal
gesproken binnen 7 dagen behandeld.

De papieren kopie kan enigszins verschillen van de
elektronische versie op uw systeem. Neem indien nodig
contact op met uw plaatselijke vertegenwoordiger voor
opheldering.

Labelpictogram | Omschrijving Labelpictogram

Omschrijving

Labelpictogram Omschrijving

Catalogusnummer
Referentienummer

ol

Fabrikant

Instructies voor gebruik
zijn beschikbaar in
elektronisch formaat

=

[l Datum fabricage @

Raadpleeg de
gebruikshandleiding

Rx Only LET OP: Volgens de
Amerikaanse federale
wetgeving mag dit
apparaat alleen worden
gekocht door of in
opdracht van een arts.
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INSTALLASJONPROSEDYRE

Programvareinstallasjon skal bare gjgres pa en datamaskin
som oppfyller minstekravene.

Les kapittel 2 av DaTQUANT-brukerveiledningen for
installasjon og aktivering neye for programvareinstallasjon.
Alle brukerveiledninger er plassert pa installasjonspakken i
mappen Help (Hjelp).

ADVARSEL: Kontroller at alle programmer lukkes for
installasjonen starter.

Det anbefales pa det sterkeste & sikkerhetskopiere alle
viktige data fgr du fortsetter med installasjonen.

Installere programmet

Etter at du har lastet ned DaTQUANT-pakken, lagrer du den
pa harddisken.

Kjer installasjonspakken, og fglg instruksjonene pa
skjermen for & fullfgre installasjonsprosedyren.

Nar programvareinstallasjonen er fullfart, kreves en omstart
av datamaskinen.

Avinstaller applikasjonen eller InSite Remote Service
Hvis du vil avinstallere hele applikasjonen, kjgrer du
installasjonspakken og velger Remove/Modify (Fjern/endre)
eller avintallerer den fra systemets kontrollpanel.

Installer lisensen

Folg instruksjonene pa skjermen i aktiverings- og
registreringsverktgyet som er tilgjengelig fra startmenyen.
Starte programmet

Programmet kan startes fra startmenyen eller snarveien pa
skrivebordet.

Last ned installasjonspakken til
datamaskinen eller en flyttbar stasjon

Du vil motta en e-post fra GEs
@ kundeservice med informasjon om
== ordrenummeret og din GE-system-ID.
(lagre denne informasjonen)

v

Kjer installasjonsprogrammet pa en
datamaskin med Windows versjon
7 eller 10.

Det er nadvendig med
administratorrettigheter.

\

Etter installasjonen fyller du ut

forespgrre aktivering.

'

Du vil motta en e-post fra GEs
kundeservice som inneholder
aktiveringsfilen (lagre denne) innen én

virkedag.

Lagre aktiveringsfilen pa datamaskinens

registreringsskjemaet og klikker nederst for
a generere og sende en e-post til GE for &

v

Teknisk statte og programvarestotte er
tilgjengelig via telefon i GEs kontortid.

<4—P yisdeter nedvendig med stette under

installasjonen eller pa et annet tidspunkt,
ma du oppgi din GE-system-ID.

harddisk, apne DaTQUANT-aktiveringsskjemaet,
klikk pa Browse (Bla gjennom), og velg den
lagrede filen.

Det er nadvendig med administratorrettigheter.
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SIKKERHETS- OG
FORSKRIFTSINFORMASJON

Unique Device Identifier (UDI) (Unik enhetsidentifikator)

Du finner UDI-koden pa applikasjonens About-skjermbilde
(Om), som du kan apne pa en av fglgende mater:
Applications (Programmer) >About (Om) / Help >

About (Om) / Start >DaTQUANT >Tools (Verktay).

Dokumentasjon

For & sikre effektiv og sikker bruk av DaTQUANT er det
avgjerende at du leser brukerveiledningen som falger med,
for du forsgker a starte. Hele dokumentasjonen er
tilgjengelig pa installasjonspakken.

Serg for at dokumentasjonen er lett tilgjengelig til enhver tid.
Du ma ikke under noen omstendigheter bruke DaTQUANT
hvis dokumentasjonen ikke er tilgjengelig. Kontakt GE-
representanten hvis du trenger hjelp.

Indikasjoner for bruk

DaTQUANT-programmet muliggjer visuell evaluering og
kvantifisering av '?I-loflupan-bilder (DaTscan™).
DaTQUANT-normaldatabasen muliggjer kvantifisering
relativ til normalpopulasjonsdatabaser for 23|-loflupan-bilder
(DaTscan™). Dette programmet kan veere til hjelp ved
registrering av tap av funksjonelle dopaminerge
nevronterminaler i striatum, som er korrelert med
Parkinsons sykdom.

Elektronisk bruksinformasjon

F=——N\

Denne programvaren leveres med et brukerhandboksett
som falger med som elektronisk bruksinformasjon. Dette er
angitt av etiketten i programvaren som bruker ikonet som er
vist ovenfor.

Brukerhandboksettet er tilgjengelig til enhver tid fra
hjelpmenyen i gverste hgyre hjgrne pa skjermbildet.

Hvis du vil laste ned den nyeste brukerhandbok-CDen og
vise eller skrive ut innholdet:

1. Apnehttps://www.gehealthcare.com/
support/support-documentation-library

2. Velg NM-koblingen (nukleaermedisin) fra listen over
modaliteter. Dette apner en ny side.

3. Under NM Products (NM-produkter) velger du
produktet NM DaTQUANT.

4. Velg Manual Types: CD (Type handbok: CD).
Klikk pa [Search] ([Sgk]).

Velg bruker-CDen pa det aktuelle spraket under
Download (Laste ned).

7. Klikk pa [Download Selected Files] ([Laste ned valgte
filer]).

8. Les informasjonen om opphavsrett, og klikk pa
[ACCEPT] ([GODTA]).

9. Klikk pa [Save] ([Lagre]), og velg banen for nedlasting.

10. Klikk p& [Open Folder] ([Apne mappel]), og pakk ut den
nedlastede filen for & fa tilgang til materialet.

o o

Merk: Bare for EU-medlemsstater

Det kan bestilles en papirkopi av brukerhandboksettet uten
noen ekstra kostnad hvis dette ikke ble levert med systemet.
Send en forespersel til salgs- eller servicerepresentanten.
Foresparselen din bar bli behandlet innen sju dager.

Denne papirkopien kan variere litt fra den elektroniske
kopien pa systemet. Ta kontakt med den lokale
representanten hvis du trenger mer informasjon.

Etikettikon = Beskrivelse Etikettikon | Beskrivelse Etikettikon | Beskrivelse
Katalognummer Produsent Bruksanvisningen finnes i
Referansenummer d elektronisk format
=
Produksjonsdato Se bruksanvisningen Rx Only FORSIKTIG: Ifelge foderal lov
&I @ kan dette utstyret kun selges
av eller etter forordning av en
lege.
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DaTQUANT ™

Oprogramowanie do analizy ilosciowej obrazéw DaTscan ™"
loflupane ( 123[)

DaTQUANT — Instrukcja obstugi w wersiji
elektronicznej (elFU) i broszura informacyjna
dla uzytkownika

OSTRZEZENIE:
Nalezy przeczytac instrukcje bezpieczenstwa znajdujgce sie w niniejszej broszurze.

Witasnos¢ firmy General Electric Company Inc.
Copyright © 2020, General Electric Company Inc. Wszelkie prawa zastrzezone

C € 0459

Rx Only

GE Medical Systems Israel,
M Functional Imaging

4 Hayozma Street

Tirat Hacarmel 30200

] 2020-03

5507043-199 wer. 4 Wersja oprogramowania: 2.0



PROCEDURA INSTALACJI

Oprogramowanie nalezy instalowa¢ wytacznie na
komputerach spetniajgcych wymagania minimalne.

Przed instalacjg oprogramowania nalezy doktadnie
zapoznac sie z trescig rozdziatu 2 dokumentu DaTQUANT
— Instrukcja instalacji i aktywacji. Wszystkie instrukcje
obstugi znajdujg sie w pakiecie instalacyjnym w folderze
,Help” (Pomoc).

OSTRZEZENIE: Przed rozpoczeciem instalacji nalezy
zamkna¢ wszystkie aplikacje.

Przed instalacjg zaleca sie wykonanie kopii zapasowych
wszystkich waznych danych.

Instalacja aplikacji

Po pobraniu pakietu DaTQUANT zapisz go na dysku
twardym.

Uruchom pakiet instalacyjny i postgpuj wedtug instrukcji na
ekranie, aby zakonczy¢ procedure instalaciji.

W celu zakonczenia instalacji oprogramowania nalezy
ponownie uruchomi¢ komputer.

Dezinstalacja aplikacji lub funkcji zdalnej ustugi InSite
Aby odinstalowac¢ catg aplikacje, nalezy uruchomi¢ pakiet
instalacyjny i wybra¢ opcje Remove/Modify (Usun/
Modyfikuj) lub dokona¢ dezinstalacji z poziomu panelu
sterowania systemu.

Instalacja licencji

Postepuj zgodnie z instrukcjami wyswietlanymi w
dostepnym z poziomu menu Start narzedziu do aktywacji i
rejestracji.

Uruchamianie aplikacji

Aplikacje mozna uruchomi¢ z menu Start lub za
posrednictwem skrétu na pulpicie.

Pobierz pakiet instalacyjny na komputer
lub dysk przenos$ny

=

Otrzymasz wiadomo$¢ e-mail z serwisu
firmy GE z numerem zamoéwienia oraz
identyfikatorem systemu firmy GE
(zachowaj te informacje)

2]

'

Uruchom instalator na komputerze z
systemem Windows w wersji 7 lub 10.

'

TN Na koncowym etapie instalacji nalezy
wypetni¢ formularz rejestraciji i kliknaé¢
tacze w dolnej czgsci ekranu, aby utworzy¢
i wysta¢ wiadomos$¢ e-mail z prosba o
aktywacje do firmy GE.

'

W ciggu 1 dnia roboczego otrzymasz
wiadomos$¢ e-mail z serwisu firmy GE z
plikiem aktywacji (zapisz go)

'

Zapisz plik aktywacji na dysku twardym
komputera, otwdérz formularz aktywacji

(Przegladaij) i wybierz zapisany plik.
Wymagane sg uprawnienia administratora.

Wymagane sg uprawnienia administratora. <>

'

Wsparcie techniczne oraz w zakresie
oprogramowania jest dostepne
telefonicznie w godzinach pracy

firmy GE. W celu uzyskania wsparcia
technicznego podczas instalacji lub w
dowolnym momencie nalezy podac
identyfikator systemu firmy GE.

aplikacji DaTQUANT, kliknij przycisk ,Browse”
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INFORMACJE DOTYCZACE
BEZPIECZENSTWA | PRZEPISOW

Unique Device Identifier (UDI, unikatowy identyfikator
urzadzenia)

Kod UDI znajduje sie na ekranie About (Informacje), ktory
mozna otworzy¢, wybierajgc kolejno nastgpujace opcje:
Applications >About (Aplikacje > Informacje) /

Help >About (Pomoc > Informacje) /

Start>DaTQUANT >Tools (Start > DaTQUANT >
Narzedzia).

Dokumentacja

Aby zapewni¢ wydajne i bezpieczne korzystanie z aplikacji
DaTQUANT, przed jej uruchomieniem nalezy zapoznac sie

z dotgczonymi instrukcjami obstugi. Kompletna
dokumentacja jest dostepna w pakiecie instalacyjnym.

Dokumentacja powinna by¢ tatwo dostgepna w kazdej chwili.
Zabronione jest korzystanie z aplikacji DaTQUANT w
przypadku braku dostepu do dokumentacji. W celu
uzyskania pomocy nalezy skontaktowac sig z
przedstawicielem firmy GE.

Wskazanie do stosowania

Aplikacja DaTQUANT umozliwia ocene wzrokowg i analize
ilosciowg obrazéw uzyskanych z uzyciem joflupanu 2|
(DaTscan™). Baza danych prawidtowych DaTQUANT
Normal Database umozliwia analize iloSciowg wzgledem
baz danych obrazéw zdrowej populacji uzyskanych z
uzyciem joflupanu 'l (DaTscan™). Aplikacja ta utatwia
wykrywanie utraty czynnosciowych zakonczen neuronéw
dopaminergicznych w ciele prgzkowanym, co jest zwigzane
z chorobg Parkinsona.

Instrukcja obstugi w postaci
elektronicznej

=Y

Niniejsze oprogramowanie dostarczane jest wraz z
zestawem podrecznikéw operatora w postaci instrukgcji
obstugi w wersji elektronicznej (elFU). Informuje o tym ikona
widoczna powyzej, umieszczona na etykiecie
oprogramowania.

Zestaw podrecznikéw operatora jest zawsze dostepny z
poziomu menu pomocy W prawym gérnym rogu ekranu
aplikaciji.

Aby pobra¢ najnowsza wersje podrecznika operatora w celu
wyswietlenia lub wydrukowania jego zawartosci:

1. Udostgpniono pod adresem https://
www.gehealthcare.com/support/support-
documentation-library

2. Na liscie technik wybierz tacze NM (medycyna
nuklearna). Zostanie otwarta nowa strona.

3. Naliscie NM Products (Produkty do medycyny
nuklearnej) wskaz produkt NM DaTQUANT.

4. Wybierz opcje Manual Types: CD.

5. Kliknij przycisk [Search] (Szukaj).

6. W kolumnie Download (Pobierz) zaznacz wybrang
wersje jezykowg dokumentacji operatora.

7. Kliknij przycisk [Download Selected Files] (Pobierz
wybrane pliki).

8. Zapoznaj sie z informacjami na temat praw autorskich i
kliknij przycisk [ACCEPT] (Akceptuj).

9. Kiiknij przycisk [Save] (Zapisz) i wskaz miejsce
zapisania pliku.

10. Kliknij przycisk [Open Folder] (Otwoérz folder) i
rozpakuj pobrany plik, aby uzyska¢ dostep do
zawartych w nim materiatow.

Uwaga: Dotyczy wytacznie panstw UE

Jezeli wersja drukowana zestawu podrecznikéw operatora

nie zostata dostarczona wraz z systemem, mozna jg

zamoéwi¢ bez ponoszenia dodatkowych kosztéw. Zgtoszenie
nalezy przesta¢ do przedstawiciela dziatu sprzedazy lub
serwisu. Odebrane zgtoszenia sg przetwarzane w ciggu

7 dni.

Wersja drukowana moze nieznacznie rozni¢ sie od wersji
elektronicznej dostgpnej w systemie. W razie potrzeby
szczegbtowe informacje mozna uzyskac¢ u lokalnego
przedstawiciela firmy GE.

lkona Description (Opis) lkona Description (Opis) lkona Description (Opis)
etykiety etykiety etykiety
Numer katalogowy Producent Instrukcja obstugi jest
Numer referencyjny d dostarczana w formie
— elektronicznej
Data produkgcji Zapoznaj si¢ z instrukcjg Rx Only PRZESTROGA: Prawo
& @ obstugi/ulotkg federalne Stanow

Zjednoczonych zezwala na
sprzedaz tego urzadzenia
wytgcznie lekarzom lub z
przepisu lekarza.
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Software quantitativo para imagens com ioflupano (’ 23[)
DaTscan ™

elFU (Informacgdes de utilizagdao em formato
eletrénico) e folheto de informagodes do utilizador
do DaTQUANT

AVISO:
Leia as instrugoes de seguranca incluidas neste folheto.
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Portugués (Portugal)

PROCEDIMENTO DE INSTALAGCAO

A instalagdo do software destina-se a ser realizada apenas
num computador que cumpra os requisitos minimos.

Leia atentamente o capitulo 2 do manual do utilizador para
instalagdo e ativagdo da DaTQUANT antes de instalar o
software. Todos os manuais do utilizador encontram-se na
pasta "Help" (Ajuda) do pacote de instalag&o.

AVISO: certifique-se de que fecha todas as aplicagoes
antes de iniciar a instalacao.

Recomenda-se vivamente a realizagdo de uma cépia de
seguranga de todos os dados importantes antes de se
prosseguir com a instalagéo.

Instalar a aplicagao

Apbs transferir o pacote DaTQUANT, guarde-o no disco
rigido.

Execute o pacote de instalagéo e siga as instrugdes
apresentadas no ecra para concluir o processo de
instalagao.

E necessario reiniciar o computador apés concluir a
instalagao do software.

Desinstalar a aplicagdo ou o servigo remoto InSite

Para desinstalar toda a aplicagéo, execute o pacote de
instalagdo e selecione "Remove/Modify" (Remover/
Modificar) ou desinstale-a a partir do painel de controlo do
sistema.

Instalar a licenga

Siga as instrucdes apresentadas no ecra da ferramenta de
ativagéo e registo disponivel a partir do menu "Start"
(Iniciar).

Iniciar a aplicagao

A aplicagdo pode ser iniciada através do menu "Start"
(Iniciar) ou do atalho no ambiente de trabalho.

Transfira o pacote de instalagéo para o
computador ou uma unidade portatil

=

Ira receber um e-mail do servigo de apoio
ao cliente da GE com indicagéo do
numero de pedido e ID do sistema GE
(guarde estas informagoes)

2]

v

a versao 7 ou 10 do Windows.

#

TN No final da instalagéo, preencha o

gerar e enviar um e-mail para a GE a
solicitar a ativagéo.

'

No espago de 1 dia util, ira receber um
e-mail do servigo de apoio ao cliente da
GE com o ficheiro de ativacéo (guarde

este ficheiro)

Execute o instalador num computador com

Séo necessérios direitos de administrador. <& -

Formulario de registo e clique no final para

v

E possivel contactar a assisténcia
técnica e a assisténcia as aplicagdes por
telefone durante o horario de
funcionamento da GE. Se for solicitada
assisténcia durante a instalagéo ou em
qualquer outro momento, tera de indicar
a ID do sistema GE.

Guarde o ficheiro de ativagdo no disco rigido
do computador, abra o formulario de ativacdo
da DaTQUANT, clique em "Browse" (Procurar)
e selecione o ficheiro guardado.

S&o necessarios direitos de administrador.
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Portugués (Portugal)

INFORMACAO DE SEGURANGA E
REGULAMENTAR

Unique Device Identifier (UDI) (Identificador exclusivo
do dispositivo)

O codigo UDI pode ser consultado no ecra About (Sobre),
ao qual pode aceder através de qualquer uma das
seguintes opgdes:

"Applications > About" (Aplicagdes > Sobre) / "Help >
About" (Ajuda > Sobre) / "Start > DaTQUANT > Tools"
(Iniciar > DaTQUANT > Ferramentas)

Documentagao

Para que seja assegurada uma utilizagao eficiente e segura
do DaTQUANT, é essencial que leia os manuais do
utilizador fornecidos antes de tentar iniciar a aplicagéao.
Toda a documentacéo encontra-se disponivel no pacote de
instalagao.

Certifiqgue-se de que a documentacéo esta sempre
disponivel. Nao deve, em circunstancia alguma, utilizar o
DaTQUANT se a documentagao ndo se encontrar
disponivel. Se necessitar de ajuda, contacte o
representante da GE.

Instrugdes de utilizagdo

A aplicagdo DaTQUANT permite a avaliagdo e

quantificagéo visuais de imagens ioflupano '23l (DaTscan™).

A base de dados normal da DaTQUANT permite a
quantificagéo relativa a bases de dados de imagens
ioflupano '2%| (DaTscan™) referentes a populagdes normais.
Esta aplicacdo podera ajudar a detetar a perda de
neurénios dopaminérgicos funcionais no striatum, que esta
associada a doenga de Parkinson.

Instrugées de utilizagdo em formato
eletrénico

Este software é fornecido com um conjunto de manuais do
operador em formato eletronico: Informagées de utilizagdo
em formato eletrénico (electronic Information For Use,
elFU). Tal é indicado através da etiqueta existente no
software, na qual é apresentado o icone acima.

O conjunto de manuais do operador encontra-se acessivel a
qualquer altura a partir do menu de ajuda que se encontra
no canto superior direito do ecra da aplicagao.

Para transferir o CD mais recente do manual do operador e
ver ou imprimir o respetivo contetddo:

1. Acedaahttps://www.gehealthcare.com/
support/support-documentation-library

2. Selecione a ligagdo NM (medicina nuclear) a partir da
lista de modalidades. Esta agao abre uma nova pagina.

3. Em NM Products (Produtos de MN), selecione o
produto DaTQUANT de NM (MN).

4. Selecione Manual Types: CD.
5. Clique em [Search] ([Procurar]).

6. Em Download (Transferir), selecione o CD do operador
no idioma apropriado.

7. Clique em [Download Selected Files] ([Transferir os
ficheiros selecionados]).

8. Leia as informagdes de direitos de autor e clique em
[ACCEPT] ([ACEITAR]).

9. Clique em [Save] ([Guardar]) e selecione o caminho
onde guardar a transferéncia.

10. Clique em [Open Folder] ([Abrir pasta]) e
descomprima o ficheiro transferido para poder aceder
ao material.

Nota: apenas para estados membros da UE

Caso nao seja fornecida com o sistema, podera ser
encomendada, sem custos adicionais, uma cépia em papel
do conjunto de manuais do operador. Envie um pedido para
o seu representante de vendas ou de assisténcia. O seu
pedido sera processado no prazo de 7 dias.

Esta copia impressa podera variar ligeiramente em relacéo
a copia eletrénica que se encontra no sistema. Caso seja
necessario, contacte o representante local para obter
esclarecimentos.

icone da Descrigdo icone da Descrigédo icone da Descrigédo
etiqueta etiqueta etiqueta
Numero de catalogo Fabricante As instrugdes de utilizagéo séo
Numero de referéncia d fornecidas em formato
— eletronico
Data de fabrico Consulte o folheto/manual de Rx Only ATENGCAO: A lei federal
& @ instrugoes restringe a venda deste
dispositivo a médicos ou por
prescricdo médica.
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ADVERTENCIA:
Leia as Instrugoes de seguranca neste livreto.

Propriedade da General Electric Company inc.
Copyright © 2020, General Electric Company Inc. Todos os direitos reservados

C€ o459

Rx Only

4 Hayozma Street

I GE Medical Systems Israel, Imagens funcionais
Tirat Hacarmel 30200

] 2020-03

5507043-199 Rev. 4 Vers3o do software: 2.0



Portugués (Brasil)

PROCEDIMENTO DE INSTALAGCAO

A instalagdo do software deve ser realizada apenas em
computadores que atendam os requisitos minimos de
instalagao.

Leia cuidadosamente o Capitulo 2 do Guia de Instalagao e
Ativagdo do DaTQUANT para usuérios antes de realizar a
instalagdo do software. Todos os guias do usuario podem
ser encontrados no pacote de instalagéo, na pasta "Help"
(Ajuda).

ADVERTENCIA: Feche todos os aplicativos antes de
iniciar a instalagao.

E altamente recomendado realizar o backup dos dados
importantes antes de proceder com a instalagéo.

Instale o aplicativo

Apds realizar o download do pacote do DaTQUANT, salve-o
em seu disco rigido.

Execute o pacote de instalagéo e siga as instrucdes que
aparecem na tela para concluir o procedimento de
instalagao.

E necessario reiniciar o computador apés concluir a
instalagao do software.

Desinstale o aplicativo ou o Insite Remote Service
Para desinstalar completamente o aplicativo, execute o
pacote de instalagéo e selecione a opgdo Remove/Modify
(Remover/Modificar) ou desinstale o aplicativo a partir do
painel de controle do sistema.

Instale a licenga

Siga as instrucdes da tela da ferramenta de ativagéo e
registro, disponivel no menu Start (Iniciar).

Para iniciar o aplicativo

O aplicativo pode ser iniciado pelo menu Start (Iniciar) ou
pelo atalho da area de trabalho.

Facga o download do pacote de instalacdo
para o computador ou HD portatil

Vocé recebera um e-mail do Servico de
atendimento ao cliente da GE com o
numero de seu pedido e a GE System
ID (ID do Sistema GE)

(salve esta informagao)

2]

'

Execute o instalador em um computador
com Windows vers&o 7 ou 10.

E necessério possuir os Administrator
rights (Direitos de administrador).

'

W No final da instalagéo, preencha o
\@/ formulario Registration (Registro) e clique

mail para a GE solicitando a ativagéo.

'

Em um dia util, vocé recebera um e-mail do

Servigo de atendimento ao cliente com o
arquivo de ativagao. (Salve o arquivo)

v

-—p

na parte inferior para gerar e enviar um e-

'

Suporte técnico e do aplicativo estéo
disponiveis por telefone durante o
horario comercial da GE. Se precisar de
suporte durante a instalagéo ou qualquer
outro momento, vocé devera fornecer
sua ID do Sistema GE.

Salve o arquivo de ativagdo no disco rigido de
seu computador, abra o formulario Activation
(Ativacédo) do DaTQUANT, clique em "Browse"
(Navegar) e selecione o arquivo salvo.

E necessario possuir os Administrator rights
(Diretos de administrador).

54



Portugués (Brasil)

INFORMAGCOES DE SEGURANGA E
REGULAMENTAGAO

Unique Device Identifier (UDI) (Identificador unico do
dispositivo - UDI)

O codigo UDI pode ser encontrado na tela About (Sobre),
que pode ser acessada das seguintes maneiras:
Applications > About / Help > About / Start > DaTQUANT
> Tools (Aplicativos > Sobre / Ajuda > Sobre / Iniciar >
DaTQUANT > Ferramentas)

Documentagao

Para garantir o uso eficiente e seguro do DaTQUANT, é
essencial que as informagdes fornecidas nos Guias do
Usuario sejam lidas antes do aplicativo ser iniciado. A
documentacdo completa esta disponivel em seu pacote de
instalagao.

Mantenha a documentag&o disponivel o tempo todo. Nao
utilize o DaTQUANT sob nenhuma circunstancia caso a
documentacdo ndo esteja disponivel. Se precisar de ajuda,
entre em contato com um representante da GE.

Indicagdes para uso

A aplicagdo DaTQUANT permite a avaliagéo visual de
imagens de '?l-ioflupano (DaTscan™). O Banco de dados
normal DaTQUANT permite a quantificagdo relativa aos
bancos de dados populacionais normais de imagens de
23]-joflupano (DaTscan™). Esse aplicativo pode auxiliar na
detecgdo de perda de terminais dos neurdnios
dopaminérgicos no neoestriado, o que € correlacionado ao
mal de Parkinson.

Informacgées de Uso Eletrénicas
F=——N\

Este software é fornecido com um conjunto de manuais do
operador denominado Informacdes de Uso Eletronicas
(elFU). Esta informag&o é indicada pelo rétulo contido no
software, através do icone mostrado acima.

O conjunto de manuais do operador pode ser acessado a
qualquer momento, pelo menu Ajuda no canto superior
direito da tela do aplicativo.

Para baixar o CD mais recente do manual do operador, e
visualizar ou imprimir seu conteudo:

1. Acesse https://www.gehealthcare.com/
support/support-documentation-library

2. Selecione o link NM (Medicina Nuclear) na lista de
modalidades. Uma nova pagina sera aberta.

3.  Em NM Products (Produtos NM), selecione o produto
NM DaTQUANT.

4. Selecione Manual Types: CD.

5. Clique em [Search] ([Pesquisar]).

6. Em Download, selecione o CD do Operador no idioma
desejado.

7. Clique em [Download Selected Files] ([Baixar
arquivos selecionados]).

8. Leia as informacgdes de direitos autorais e clique em
[ACCEPT] ([ACEITAR]).

9. Clique em [Save] ([Salvar]) e selecione o caminho para
realizar o download.

10. Clique em [Open Folder] ([Abrir pasta]) e descompacte
o0 arquivo baixado para acessar o material.

Observagao: Apenas para os Estados-membros da UE

Caso ndo tenha sido fornecida com o sistema, uma cépia
em papel do conjunto de manuais do operador pode ser
solicitada gratuitamente. Envie a solicitagdo para o seu
representante de vendas ou de servigos. Sua solicitacdo
deve ser atendida em até 7 dias.

Essa copia em papel pode ser ligeiramente diferente da
copia eletronica fornecida com o sistema. Se necessario,
entre em contato com o seu representante local para mais
esclarecimentos.

icone da Descrigdo icone da Descrigdo icone da Descrigédo
etiqueta etiqueta etiqueta

Numero de catalogo Fabricante Instrugdes de uso séo
Numero de referéncia d fornecidos em formato

— eletronico

Data de fabricagédo Consulte o Manual de Rx Only CUIDADO: A lei federal limita a

& @ Instrugdes/livreto venda deste dispositivo por ou
por ordem de um médico.
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Romana

PROCEDURA DE INSTALARE

Instalarea software-ului trebuie efectuata doar pe un
computer care indeplineste cerintele minime.

Va rugam sa cititi cu atentie Capitolul 2 al Ghidului de
instalare si activare DaTQUANT inainte de instalarea
programului software. Toate ghidurile de utilizare se afla in
pachetul de instalare din folderul Help (Ajutor).
AVERTISMENT: va rugam sa va asigurati ca ati inchis
toate aplicatiile inainte de inceperea instalarii.

Se recomanda insistent sa faceti copii de siguranta pentru
toate datele importante Tnainte de a continua cu instalarea.
Instalarea aplicatiei

Dupa instalarea pachetului DaTQUANT, salvati-l pe unitatea
de hard disk.

Executati pachetul de instalare si continuati cu instructiunile
de pe ecran pentru a finaliza procedura de instalare.
Instalarea programului software necesita repornirea
computerului dupa finalizare.

Dezinstalarea aplicatiei sau a Serviciului la distanta
InSite

Pentru a dezinstala toata aplicatia, executati pachetul de
instalare si alegeti Remove/Modify (Eliminare/Modificare)
sau dezinstalati-o din panoul de control al sistemului.

Instalarea licentei

Urmati instructiunile de pe ecran din instrumentul de
activare si inregistrare disponibil din meniul Start.

Lansarea aplicatiei

Lansarea aplicatiei se poate face din meniul Start sau de la
comanda rapida de pe desktop.

Descarcati pachetul de instalare pe
computer sau pe o unitate portabila

Veti primi un e-mail de la Serviciul pentru
clienti GE, care contine numarul comenzii
si ID-ul sistemului GE

(salvati aceste informatii)

2]

'

Executati programul de instalare pe un
computer cu Windows versiunea 7 sau 10.
Sunt necesare drepturi de administrator.

'

N La sfarsitul instalarii, completati formularul
\@/\ de fnregistrare si faceti clic in partea de jos
pentru a genera si a trimite un e-mail la GE
pentru a solicita activarea.

'

in termen de 1 zi lucratoare, veti primi un e-
mail de la Serviciul pentru clienti GE care
contine fisierul de activare (a se salva)

#

(Rasfoire) si selectati fisierul salvat.
Sunt necesare drepturi de administrator.

Salvati figierul de activare pe unitatea de hard
disk a computerului, deschideti formularul de
activare DaTQUANT, faceti clic pe ,Browse”

'

Este disponibila asistenta tehnica si
pentru aplicatii prin telefon, in timpul
orelor de program ale companiei GE.
Daca este solicitata asistenta in timpul
instalarii sau in orice moment, va fi
nevoie sa furnizati ID-ul sistemului GE.
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Romana

INFORMATII PRIVIND SIGURANTA $I
REGLEMENTARILE

Unique Device Identifier (UDI) (Identificatorul unic al
dispozitivului)

Codul UDI poate fi gasit pe ecranul About (Despre) al
aplicatiei, care poate fi accesat prin oricare dintre
urmatoarele optiuni:

Applications (Aplicatii) >About (Despre)/

Help >About (Despre)/ Start>DaTQUANT >Tools
(Instrumente).

Documentatie

Pentru a asigura utilizarea eficienta si in siguranta a
DaTQUANT, este esential sa cititi ghidurile de utilizare
furnizate Tnainte de a incepe. Toata documentatia este
disponibila in pachetul de instalare.

Asigurati-va ca documentatia este disponibila in
permanenta. Nu utilizati in niciun caz DaTQUANT daca
documentatia nu este disponibila. Daca aveti nevoie de
ajutor, va rugam sa contactati reprezentatul GE.

Indicatii de utilizare

Aplicatia DaTQUANT permite evaluarea si cuantificarea
vizuala a imaginilor '#l-ioflupan (DaTscan™). Optiunea
Normal Database (Baza de date normala) din DaTQUANT
permite cuantificarea relativa la bazele de date de imagini
23]-joflupan (DaTscan™) cu populatie normala. Aceasta
aplicatie poate asista la detectarea pierderii terminatiilor din
corpul striat ale neuronilor dopaminergici functionali, situatie
care este asociata cu boala Parkinson.

Informatii de utilizare in format
electronic

Acest software este furnizat impreuna cu un set care include
manualul de utilizare, oferit ca Informatii de utilizare in
format electronic (elFU). Acest fapt este indicat de eticheta
din software utilizadnd pictograma afisata mai sus.

Setul de manuale de operare este accesibil in orice moment
din meniul help (ajutor) din coltul din dreapta sus al
ecranului aplicatiei.

=Y

Pentru a descarca cel mai recent CD cu manualul de
utilizare, pentru a vizualiza sau tipari continutul acestuia:

1. Accesati https://www.gehealthcare.com/
support/support-documentation-library

2. Selectati linkul NM (Medicina nucleara) din lista de
modalitati. Aceasta actiune va deschide o pagina noua.

3. In campul NM Products (Produse NM), selectati
produsul NM DaTQUANT.

4. Selectati Manual Types: CD.

5. Faceti clic pe [Search] ([Cautare]).

6. In Download (Descarcare), selectati CD-ul pentru
operator in limba adecvata.

7. Faceti clic pe [Download Selected Files] ([Descarcare
fisiere selectate]).

8. Cititi informatiile despre drepturile de autor si faceti clic
pe [ACCEPT] ([Acceptare]).

9. Faceti clic pe [Save] ([Salvare]) si selectati calea pentru
descarcare.

10. Faceti clic pe [Open Folder] ([Deschidere folder]) si
dezarhivati fisierul descarcat pentru a accesa
materialul.

Nota: Numai pentru statele membre UE

Daca nu I-ati primit deja impreuna cu sistemul, puteti

comanda un set cu manualul de utilizare in format tiparit pe

hartie fara costuri suplimentare. Trimiteti o solicitare
reprezentantului dvs. din departamentul Vanzari sau

Service. Solicitarea dvs. va fi procesata in termen de 7 zile.

Este posibil ca exemplarul pe hartie sa difere putin de
varianta electronica din sistem. Daca este necesar,
contactati reprezentantul local pentru clarificari.

Data fabricatiei @

cu instructiuni

Pictograma | Descriere Pictograma Descriere Pictograma | Descriere
etichetei etichetei etichetei
Numar de catalog Producétor Instructiunile de utilizare sunt
Numar de referinta d furnizate in forma electronica
=
I:l Consultati manualul/brogsura | Rx Only ATENTIE: Legea federala nu

permite comercializarea
acestui dispozitiv decat de
catre medic sau la
recomandarea acestuia.
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NPOLIEQYPA YCTAHOBKU

Mpoueaypy ycTaHoBKM NporpaMmHoro obecneyeHns
HeoBXOAMMO BbINOMHATL HA KOMMbIOTEPE, XapaKTepUCTUKN
KOTOPOrO COOTBETCTBYKOT MUHVUMArbHLIM TPEGOBaHNSM.

Mepen ycTaHoBKOW NporpaMmHoro obecneyveHns
BHUMaTENbHO U3yyuTe rnaey 2 pykogodcmea o
ycmaHoske u akmusayuu rpunoxerHuss DaTQUANT. Bce
PYKOBOACTBa NOMb30BaTENs HAXOAATCS B YCTAHOBOYHOM
nakete B nanke «Help» (Cnpaska).

OCTOPOXHO! Nepea Hayanom ycTaHOBKMN
Heo6X0AMMO 3aKpbITb BCE NPUIOXEHUA.

Mepen BbINONHEHNEM YCTAHOBKW HAaCTOATENIbHO
pekomeHAyeTCsi Co3aTh Pe3epBHbIE KOMUM BCEX BaXHbIX
[aHHbIX.

YcTaHoBKa NpunoxeHus

Mocne 3arpyskn naketa DaTQUANT coxpaHuTe ero Ha
KECTKOM JuncKe.

3anycTute ycTaHOBOYHbIN NaKeT U NP BbINMOMHEHWN
YCTaHOBKM CrieflyiiTe MHCTPYKLMSIM Ha 3KpaHe.

Mo 3aBepLUEHNN YCTaHOBKM NPOrpamMmMHOro obecneveHus
notpebyeTcs nepesarpyaka KomrbloTepa.

YnaneHue npunoxeHus unu hyHKLMN yaaneHHoro
o6enyxuBaHus InSite

YTo6bl NOMHOCTbLIO YAANUTL NPUIIOXEHME, 3anyCcTuTe
yCTaHOBOYHBbIN NakeT u Bbibepute nNyHKT «Remove/Modify»
(Ypanutb/VIameHnuTtb) nnbo yaanute NpunoxeHue ¢
NOMOLLbIO MaHenu ynpaeneHusi CUCTEMBbI.

YcTaHOBKa NULIEH3UN

CrnepyiiTe NHCTPYKLMSIM B OKHE MHCTPYMEHTa akTuBaLuvn v
perucTpaumm, KOTopbIi OTKPLIBAETCS C MOMOLLbIO MEHI0
«Start» (Myck).

3anyck npunoxeHus

MpunoxeHne MOXHO 3anyCTUTb C MOMOLLIbIO MEHIO
«Start» ([yck) unu spneika Ha paboyem cTone.

\ 3arpyauTte yCTaHOBOYHbIN NakeT Ha

3 KOMMbIOTEP WM NePeEHOCHOE YCTPOICTBO

Mo aneKkTpoHHOW NoYTe Bam npuaeT
NMCbMO OT CNYXObl NOAAEPXKKN KNTNEHTOB
KoMnaHun GE ¢ Homepom 3akasa u
naeHTudukatopom cuctemol GE
(coxpaHuTe 3TU cBeAeHUs)

2]

3anycTute nporpaMMy yCTaHOBKM Ha
komnbtoTepe ¢ OC Windows Bepcun 7
mnu 10.

& Heobxodumsi npasa adMuHUcmpamopa.
At Mocne 3aBepLUEHUs YCTaHOBKM 3anonHuTe
@’ hopMy permcTpaumm u HaxxMuTe BHU3Y

KHOMKY, 4TOGbl OTNPaBUTL B koMnaHuio GE
NUCLMO C 3aMpPOCOM aKTUBaLMK.

B TeueHune 1 paboyero gHsi no
3N1EeKTPOHHOW NOoYTe Bam NpMAET NUCbMO
OT cnyx0bl NOAAEPXKKN KNUEHTOB
komnaHun GE ¢ dannom aktusaumm
(coxpaHuTe ero).

CoxpaHuTe haitn akT1Bauum Ha KeCTKoM
‘v AncKe KomnbloTepa, OTkponTe hopmy
aktuBauun npunoxeHns DaTQUANT,
HaxMuTe KHorKy «Browse» (O630p) n
BblbepuTe COXpaHEHHbIN thain.
Heobxo0umbi npasa admuHucmpamopa.

3a TexHu4eckow nogaepXKon 1 NOMOLLbIO NO
paboTe ¢ npunoxeHusiMu obpallantecs B
komnaHuio GE no tenedoHy B paboyee
Bpemsi. Ecnu Heobxoauma nomolub Bo BpeMst
yCTaHOBKM Unu B nto6oe Apyroe Bpemsi, Hy>HO
coobLWWTb cneumanncTy naeHTudukaTop
cuctembl GE.
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UHOOPMALMUA MO TEXHUKE
BE3OMNACHOCTU U HOPMATUBHAS
NHOOPMALUA

YHukanbHbI napeHTUdnkaTop ycrpomcraa (UDI)

WpeHtudumkatop UDI ykasbiBaeTcsa B okHe About
(O cucreme), KOTOPOE MOXHO OTKPbITb OOAHUM U3
cneayoLmx cnocobos:

Applications >About (Mpunoxexus > O cucteme) /
Help >About (Cnpaska > O cucreme) /
Start>DaTQUANT >Tools (Myck > DaTQUANT >
VIHCTPYMEHTBI).

[oKkymeHTauums

[inga acpcpekTnBHOM 1 BesonacHow aKkcnnyaTaumm
npunoxennss DaTQUANT nepeg ero 3anyckom Heo6xoammo
03HaKOMMUTBCS C MpUnaraloLLMMCs PyKoBoACTBaMu
nonb3oBatens. Bca gokymeHTaumst HaxoaMTCA B BalleM
yCTaHOBOYHOM nakete.

Heobxoaumas AokymeHTaums Bceraa AofmkHa 6biTb noa
pykon. Hu npu kakux o6cTonaTenbCTBax He UCNonb3ynTe
npunoxexnne DaTQUANT, ecnu gokymeHTaums
HepocTynHa. MNpu HeobxoanMocTM obpaTtuTecs 3a
NOMOLLbIO K NpeacTaBuTento komnanmm GE.

HasHnauyeHue

Mpunoxernne DaTQUANT obecneunBaeT BU3yarnbHyo 1
KOJNIMYECTBEHHYIO OLIEHKY M306paXKeHUiA, NONyYeHHbIX C
ncnonb3oBaHveM paguodapmnpenapata '2%l-nocnynaH
(DaTscan™). basa gaHHbix HopMbl DaTQUANT nossonsiet
NpPOBOANTbL KONMYECTBEHHOE CpaBHeHMe ¢ 6a301 AaHHbIX
1306paxeHunin, Nony4YeHHbIX C UCNOMb30BaHNeEM
pagvodapmnpenapara ??l-nocnynaH (DaTscan™) y
300pOBbIX NtoAen. ATO NPUNOXKEHNE MOXET NOMOYb B
BbISIBNIEHUMN yTpaThbl PYHKLMOHANbHBIX 4OMaMUHIPIUYECKNX
HEePBHbIX OKOHYaHWI B CTpUaTyme, KOTOpas cBsizaHa C
6onesHblo MapkMHCOHa.

Sr1eKmpoHHbIe UHCMPYKUUU
no akcnnyamayuu

B KOMMMeKT NocTaBku 4aHHOTO NPOrpamMMHOro
obecneyeHnst BXOAUT KOMMINEKT PyKOBOACTB onepartopa,
npunaraeMbix B (popme 3neKTPOHHbIX MHCTPYKLWIA No
akcnnyaTauum (elFU). Ha aTo yka3biBaeT MapkupoBka B
nporpamMmMHom obecneveHnmn ¢ NpvBeAeHHbIM Bbille
3HAYKOM.

=Y

[locTyn K KOMMNAEKTY PyKOBOACTB onepaTopa BO3MOXEH B
no6oe Bpemsi C MOMOLLbKO MEHIO CNIPABKM1, PACNONOXEHHOM
B NPaBOM BEPXHEM YITly 3KpaHa NpuUoxeHus.

[nsi 3arpy3ku nocnegHen coaepxallencs Ha KOMMnaKT-
[ViCKe BEPCUW PYKOBOACTBA OrnepaTtopa, a Takke NpocMoTpa
1 neyaTun ero CoAepXMmoro:

1. TlepenauTe no ccbinke https://
www.gehealthcare.com/support/support-
documentation-library.

2. B cnucke metonos BbibepuTe nyHKT «NM» (AoepHas
MeauumHa). OTKpoeTcst HoBasi cTpaHuua.

3. B cnucke NM Products (Cuctembl pagnoHyknngHon
AnarHocTukm) Boibepute «NM DaTQUANT»
(Mpunoxexne DaTQUANT ans paguoHyKnuaHoi
OVarHoCTUKw).

4. Bblbepute nyHkT Manual Types: CD.

Haxmute [Search] ([Momck]).

6. B cnucke Download (3arpyska) BbibepuTe komnakT-
ANCK C AOKYMeHTaLUMel Ans onepaTtopa Ha Hy>KHOM
A3blKe.

7. HaxwmuTe [Download Selected Files] ([3arpysuTb
BblGpaHHble haiinbl]).

8. T[poutute nHbopmaLmio 06 aBTOPCKMUX NpaBax u
Haxmute [ACCEPT] ([MPUHATH]).

9. Haxwmute [Save] ([CoxpaHuTb]) 1 BibepuTe NyTb ANA
3arpysku.

10. Haxmute [Open Folder] ([OTkpbITb Nanky]) n
pacnakyvte apxuB C 3arpyxeHHbiM chanom ans
fAocTyna K matepuanam.

o

MpumeyaHue: Tonbko AnA cTpaH-yyacTHuy EC

B cnyyae ecnu 6ymaxHasi konus pykoBoACTBa ornepartopa
He Bbina NocTaBneHa B KOMMMEKTE C CUCTEMOM, Bbl MOXeTe
3aka3aTb ee 6e3 gononHuTensHomn onnatbl. OTnpaBbTe
3anpoc TOpProBomy npeAcTaBUTesNto NNy NpeacTaBuTento
cepBuCHOM cnyx6bl B Ballem pernoHe. Baw 3anpoc 6yaet
paccMOTpeH B TeueHve 7 AHew.

[aHHas 6ymaxHas Konusa MOXeT HECKOMbKO OTNNYaTbCs OT
ANEeKTPOHHOW KONWUW, UMEIOLLIENCS B BaLLen cucteme.

Mpwn HeobxoaumocT o6paTUTECH K PErMoHansHOMy
npeacTaBuTENto AN NONYyYEHUS Pa3bsSCHEHNIA.

3Havyok Ha | Onucanue

ITUKETKe

3Havyok Ha | Onwucanue

ITUKeTKe

3Ha4yok Ha | Onucanue

ITUKETKe

Howmep no katanory
Homep usgenus

paal
©

[ata narotoBneHus

o]

Warotosutens

O6patuTech k MHCTPYKUUM /
GpoLutope No akcnnyaraumm

PyKOBO[J,CTBO no akcnnyatauun
npenocTasndeTca B BJ'ISKTpOHHOVI
dopme

=

Rx Only BHUMAHWE! ®epepansHoe
3aKOHO[ATeNbLCTBO OrpaHNYnBaeT
npoAaxy AaHHOro ycTponcTea

Bpayam vunu no nx npeanucaHuto.
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POSTUP INSTALACIE

Indtalaciu softvéru treba vykonat len na pogitadi, ktory spifia
minimalne pozZiadavky.

Pred inStalaciou softvéru si dokladne preditajte kapitolu

2 v pouzivatelskej priru¢ke na instalaciu a aktivaciu softvéru
DaTQUANT. V3etky pouzivatelské priru€ky sa nachadzaju
v indtalaénom baliku v prie¢inku ,Help* (Pomoc).
VAROVANIE: Pred zaciatkom instalacie overte, ¢i ste
zavreli vSetky aplikacie.

Dérazne odporu¢ame, aby ste si pred pokracovanim

v inStalacii zalohovali vSetky dolezité udaje.

Instalacia aplikacie

Po stiahnuti balika DaTQUANT uloZte balik na pevny disk.
Spustite inStalaény balik a podla pokynov na obrazovke
dokoncite postup instalacie.

InStalacia softvéru si po dokonéeni vyzaduje restart
pocitaca.

Odinstalovanie aplikacie alebo vzdialeného servisu
InSite

Ak chcete odinstalovat celu aplikaciu, spustite inStalaény
balik a vyberte polozku Remove/Modify (Odstranit/upravit)
alebo ju odinstalujte z ovladacieho panela systému.
InStalacia licencie

Postupuijte podla pokynov na obrazovke v nastroji na
aktivaciu a registraciu, ktory je dostupny v ponuke Start
(Start)

Spustenie aplikacie

Aplikaciu mozno spustit z ponuky Start (Start) alebo
prostrednictvom odkazu na pracovnej ploche.

Stiahnite si inStalacny balik do pocitaca
alebo na prenosnu jednotku

Z oddelenia sluzieb pre zakaznikov
spolo¢nosti GE dostanete e-mail, ktory
bude obsahovat ¢islo vasej objednavky
a ID systému GE

(tieto informacie si ulozte)

2]

'

Instalacny program spustite v pogitaci so
systémom Windows, verzia 7 alebo 10.
VyZaduju sa opravnenia spravcu.

'

Na konci inStalacie vyplrite registracny
formular a kliknutim do dolnej Casti
generujte a odoslite e-mail so Ziadostou
o aktivaciu do spolo¢nosti GE.

'

Do 1 pracovného dna dostanete e-mail od
oddelenia sluzieb pre zakaznikov
spolo¢nosti GE, ktory bude obsahovat
aktivaény subor (ulozte si ho)

'

UlozZte aktiva¢ny subor na pevny disk
pocitaca, otvorte aktivacny formular
DaTQUANT, kliknite na polozku ,Browse*
(Prehladavat) a vyberte ulozeny subor.
VyZaduju sa opravnenia spravcu.

'

Telefonicka technicka a aplikacna
podpora je k dispozicii po¢as pracovnych
hodin spolo¢nosti GE. Ak sa vyZaduje
podpora pocas instalacie alebo

v lubovolnom inom ase, bude potrebné,
aby ste uviedli ID systému GE.
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BEZPECNOSTNE A REGULACNE
INFORMACIE

Unique Device Identifier (UDI) (Jedine¢na identifikacia
zariadenia (UDI))

Kaéd jedine¢nej identifikacie UDI najdete na obrazovke
aplikacie About (Informacie o programe), pristup na ktort
ziskate pouzitim niektorej z nasledujucich moznosti:
Applications >About / Help >About / Start >
DaTQUANT >Tools (Aplikacie > Informacie o programe/
Pomoc > Informécie o programe/Start > DaTQUANT >
Nastroje).

Dokumentacia

Pred spustenim aplikdcie DaTQUANT si musite precitat
dodané pouzivatelské prirucky. Zaistite tym efektivne

a bezpecné pouzivanie tejto aplikacie. Cela dokumentacia
je dostupna v inStalaénom baliku.

Zabezpecte, aby bola dokumentéacia vzdy lahko dostupna.

V opacnom pripade nesmiete aplikaciu DaTQUANT za
ziadnych okolnosti pouzivat. Ak potrebujete pomoc,
kontaktujte zastupcu spolo¢nosti GE.

Indikacia pouzitia

Aplikdcia DaTQUANT umozriuje vizualne vyhodnotit

a kvantifikovat obrazy so '?l-joflupanom (DaTscan™).
Normalna databaza DaTQUANT umoziiuje vykonavat
kvantifikaciu vztahujucu sa databazy obrazov so '#I-
joflupanom (DaTscan™) normalnej populacie. Tato
aplikacia méze sluzit ako pomdcka pri detekcii straty
funkénych dopaminergickych neurénovych zakonéeni
v corpus striatum, ¢o suvisi s Parkinsonovou chorobou.

Informadcie o pouzZivani
v elektronickej podobe

Tento softvér sa dodava so supravou priruciek pre
operatora v elektronickej podobe pod nazvom Informacie
o pouzivani (electronic Information For Use — elFU).
Oznacuje to Stitok na softvéri s hore uvedenou ikonou.
Suprava priru€iek pre operatora je dostupna kedykolvek
v ponuke pomocnika v pravom hornom rohu obrazovky
aplikacie.

Ak chcete prevziat najnovsiu priru¢ku pre operatora na
disku CD a zobrazit alebo vytlacit jej obsah:

1. Otvorte stranku https://www.gehealthcare.com/
support/support-documentation-library

2. Zozoznamu modalit vyberte prepojenie NM (Nuklearna
medicina). Otvori sa nova stranka.

3. V zozname NM Products (Produkty NM) vyberte
produkt NM DaTQUANT.

4. Vyberte Manual Types: CD (Typy manualov: CD).

5. Kliknite na tlacidlo [Search] (Vyhladat).

6. V Casti Download (Prevziat) vyberte Operator CD (CD
pre operatora) v prisluSnom jazyku.

7. Kliknite na tlacidlo [Download Selected Files]
(Prevziat zvolené subory).

8. Predcitajte si informacie o autorskych pravach a kliknite
na [ACCEPT] (Prijat).

9. Kliknite na [Save] (Ulozit) a vyberte umiestnenie na
prevzatie suboru.

10. Kliknite na moznost [Open Folder] (Otvorit prie€inok)
a rozbalte prevzaty subor, aby ste ziskali pristup
k materialu.

Poznamka: Len pre élenské staty EU

Ak ste so systémom nedostali sériu priruciek pre operatora,

mozete si bezplatne objednat ich tlacenu verziu. Poslite

Ziadost' svojmu obchodnému alebo servisnému zastupcovi.

Vas$a ziadost bude vybavena do 7 dni.

Tlaena verzia sa méze mierne odliSovat od elektronickej

verzie vo vasom systéme. Ak si nie ste nie¢im isti,

kontaktujte miestneho zastupcu.

Ikona sStitka | Popis

lkona stitka | Popis

lkona stitka | Popis

Datum vyroby @

k zariadeniu/brozurku

federalneho zakona USA sa
toto zariadenie moze
predavat vylu¢éne lekarovi
alebo na objednavku lekara.

Katalégové ¢islo Vyrobca Pokyny na pouzivanie su
Referencéné Cislo d dodavané v elektrickej forme
=
[l Preditajte si prirucku Rx Only UPOZORNENIE: Podla
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INSTALLATIONSPROCEDUR

Programvaruinstallationen ska endast géras pa en dator
som uppfyller minimikraven.

Las kapitel 2 i DaTQUANT Anvéndarhandbok fér installation
och aktivering noggrant fére programvaruinstallationen. Alla
anvandarhandbdcker finns i installationspaketet i mappen
Help.

VARNING: Kontrollera att alla program &r stingda innan
du pabdrjar installationen.

Vi rekommenderar att du sakerhetskopierar alla viktiga data
innan du fortsatter med installationen.

Installera programmet

Nér du har hamtat DaTQUANT-paketet sparar du det pa
harddisken.

Kor installationspaketet och slutfér installationen genom att
félja anvisningarna pa skarmen.

Datorn maste startas om nér programvaruinstallationen har
slutforts.

Avinstallera programmet eller InSite-fjarrservice

Om du vill avinstallera hela programmet kor du
installationspaketet och véljer Ta bort/Andra i
Kontrollpanelen for systemet.

Installera licensen

Folj anvisningarna som visas pa skarmen i aktiverings- och
registreringsverktyget som du dppnar fran Start-menyn.
Starta programmet

Du kan 6ppna programmet fran Start-menyn eller via
skrivbordsgenvagen.

Hamta installationspaketet pa datorn eller
en lostagbar enhet

Du far ett e-postmeddelande fran GE:s
kundtjanst med ditt bestallningsnummer
och ID:t for GE-systemet

(spara informationen)

2]

'

Kor installationsprogrammet pa en dator
med Windows version 7 eller 10.
Administratérsbehérighet krévs.

#

Nar installationen har slutforts fyller du i
registreringsformuléret och klickar langst
ned for att generera och skicka ett e-
postmeddelande till GE for att begéra

aktivering.

Inom en arbetsdag far du ett
e-postmeddelande fran GE:s kundtjanst
med aktiveringsfilen (spara den)

'

6ppna DaTQUANT-aktiveringsformularet,

Administratérsbehérighet krévs.

-—p

Spara aktiveringsfilen pa datorharddisken,

klicka pa Bladdra och valj den sparade filen.

v

Du kan fa teknisk support och
programsupport via telefon under GE-
kontorstid. Om du behdver support under
installationen eller vid nagot annat tillfalle
maste du tillhandahalla ID:t for GE-
systemet.
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INFORMATION OM SAKERHET OCH
REGLER

Unique Device Identifier (unikt enhets-id) (UDI)

UDI-koden anges pa skarmen About (om) i programmet.
Du kan &ppna skarmen pa nagot av féljande satt:
Program >About (om) / Help >About (om) /
Start>DaTQUANT >Tools (verktyg).

Dokumentation

Du bor lasa de medféljande anvandarhandbdckerna innan
du borjar anvanda DaTQUANT for att sakerstélla effektiv
och séker anvandning av programvaran. All dokumentation
finns i installationspaketet.

Se till att dokumentationen alltid finns Iatt tillganglig. Under
inga omstandigheter ska DaTQUANT anvandas om
dokumentationen inte ar tillganglig. Om du behdver hjalp
kontakter du en GE-representant.

Bruksanvisning

DaTQUANT-programmet har funktioner for visuell
beddmning och kvantifiering av '2*l-loflupane-bilder
(DaTscan™). Normala databaser i DaTQUANT har en
funktion for kvantifiering som ar relativ till normala
populationsdatabaser med '2*l-loflupane-bilder
(DaTscan™). Programmet kan anvandas som hjalpmedel
vid férlustdetektion av funktionella dopaminergiska
nervcellsandar i striatum, som har samband med
Parkinsons sjukdom.

Tilldgg till elektronisk bruksanvisning

F=——N\

Programvaran levereras med en anvandarhandbok som

tillhandahalls i form av en elektronisk bruksanvisning (elFU).

Det anges med att ikonen som visas ovan finns pa etiketten

for programvaran.

Du kan 6ppna anvandarhandboken nar du vill fran

hjélpmenyn langst upp till hdger pa programskarmen.

H&mta den senaste cd-skivan med anvandarhandboken och

visa eller skriv ut innehallet:

1. Oppna https://www.gehealthcare.com/
support/support-documentation-library

2. Valjlanken NM (nuklearmedicin) i listan med
modaliteter. En ny sida éppnas.

3. ValjNM DaTQUANT under NM Products (NM-
produkter).

4. Valj Manual Types: CD.

5. Klicka pa [Search] ([sOk]).

6. Under Download (hdmta) véljer du anvandar-cd-skivan
pa lampligt sprak.

7. Klicka pa [Download Selected Files] ([hdmta valda
filer]).

8. Las copyright-texten och klicka pa [ACCEPT]
([accepteral]).

9. Klicka pa [Save] ([spara]) och valj sokvéag for hamtning.

10. Klicka pa [Open Folder] ([6ppna mapp]) och zippa upp
de hamtade filerna for att 6ppna materialet.

Obs! Endast for EU-medlemsstater

Om en papperskopia av anvandarhandboken inte medféljde

systemet kan du bestélla den utan extra kostnad. Skicka en

forfragan till sélj- eller servicerepresentanten. Din forfragan

behandlas inom 7 dagar.

Papperskopian kan skilja sig nagot fran det elektroniska
exemplaret i systemet. Kontakta en lokal representant om
du behdver mer information.

Tillverkningsdatum @

instruktionshandboken-/haftet

Etikettikon = Beskrivning Etikettikon | Beskrivning Etikettikon | Beskrivning
Katalognummer Tillverkare Anvéandarhandbok
Referensnummer d tillhandahalls i elektroniskt
=—== format
I:l Mer information finns i Rx Only FORSIKTIGHET: Enligt federal

lagstiftning i USA far den har
enheten endast séljas av
lakare eller pa ordination av
lakare.
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KURULUM PROSEDURU

Yazilim kurulumu yalnizca minimum gereksinimleri
kargilayan bir bilgisayarda yapiimalidir.

Yazilim kurulumundan &énce lutfen DaTQUANT Kullanici
Kurulum ve Etkinlegtirme Kilavuzu, Bélum 2'yi dikkatli bir
sekilde okuyun. Tim kullanici kilavuzlari "Help" (Yardim)
klasoriinln altindaki kurulum paketinde bulunur.

UYARI: Liitfen kuruluma baslamadan 6nce tiim
uygulamalari kapattiginizdan emin olun.

Kuruluma devam etmeden 6nce 6énemli verilerin timini
yedeklemeniz siddetle nerilir.

Uygulamayi kurma

DaTQUANT paketini indirdikten sonra sabit siiriclinlize
kaydedin.

Kurulum paketini calistirin ve ekrandaki talimatlari
uygulayarak kurulum proseduriini tamamlayin.

Yazilim kurulumu igin kurulum tamamlandiktan sonra
bilgisayarin yeniden baslatiimasi gerekir.

Uygulama veya InSite Remote Service'l Kaldirma
Uygulamanin tamamini kaldirmak igin kurulum paketini
calistirin ve sistem kontrol panelinden Remove/Modify
(Kaldir/Degistir) ya da programi kaldirma segenegini
belirleyin.

Lisansi kurma

Start (Baslat) menusiinden erisilen etkinlestirme ve
cakistirma aracinin ekraninda verilen talimatlari izleyin.
Uygulamayi baslatma

Start (Baslat) menisiini veya masausti kisayolunu
kullanarak uygulamayi baslatabilirsiniz.

Kurulum paketini bilgisayara veya
taginabilir stirlictye indirin

GE Mdsteri Servisi tarafindan siparis
@ numaranizi ve GE System ID'nizi (GE
== Sistem Kimligi) iceren bir e-posta
gonderilir
(bu bilgiyi kaydedin)

'

sUrimind kullanan bir bilgisayarda
cahistirin.
Administrator rights (Yonetici haklari)

gereklidir. ‘

\@j\ Kurulum sonunda Registration (Kayit)

ilgili bir e-posta olusturarak GE'ye
gondermek igin asagidaki baglantiya

tiklayin.

1 is glind icinde GE Musteri Hizmeti

bir e-posta alirsiniz (bunu kaydedin)

#

Kurulum programini Windows 7 veya 10

formunu doldurun ve etkinlestirme istegi ile

tarafindan etkinlestirme dosyasini iceren

v

GE sirketinin ¢alisma saatleri dahilinde
telefonla teknik destek ve uygulama

- - destegi saglanabilir. Kurulum sirasinda

veya baska bir zamanda destege
ihtiyaciniz duyarsaniz GE System ID'nizi
(GE Sistem Kimligi) belirtmeniz gerekir.

Etkinlestirme dosyasini bilgisayarinizin sabit
surtictsune kaydedin, DaTQUANT Activation form'u
(Etkinlestirme formu) agin, "Browse" (Gozat)
6gesine tiklayin ve kaydedilen dosyay! segin.
Administrator rights (Yonetici haklari) gereklidir.
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GUVENLIK VE YASAL DUZENLEME
BILGILERI

Unique Device Identifier (UDI) [Benzersiz Cihaz
Tanimlayici (UDI)]

UDI kodu uygulamanin About (Hakkinda) ekraninda
bulunabilir. Bu ekrana su yollardan birini kullanarak
erigebilirsiniz:

Applications > About (Uygulamalar > Hakkinda) / Help >
About (Yardim > Hakkinda) / Start > DaTQUANT > Tools
(Baglat > DaTQUANT > Araglar).

Belgeler

DaTQUANT sistemini etkili ve giivenli bir sekilde
kullanabilmek igin cihazi baglatmadan 6nce verilen Kullanici
Kilavuzlarini okumaniz ¢ok 6nemlidir. Kurulum paketinde
tim belgeleri bulabilirsiniz.

Belgelerinizin her zaman elinizin altinda oldugundan emin
olun. Belgeleriniz yoksa DaTQUANT sistemini kesinlikle
kullanamazsiniz. Yardima ihtiyaciniz varsa lutfen GE
temsilcisine bagvurun.

Kullanim amaci

DaTQUANT uygulamasi, '?l-loflupane (DaTscan™)
gorantulerinin gorsel olarak degerlendirilmesini ve
kantifikasyonunu saglar. DaTQUANT Normal Database
(Normal Veritabani), '2I-loflupane (DaTscan™)
gorantdlerinin normal popilasyon veritabanlarina gére
kantifikasyonunu saglar. Bu uygulama, Parkinson
hastaligiyla iliskilendirilen, striatumda fonksiyonel
dopaminerjik néron terminali kaybinin saptanmasina
yardimci olabilir.

Elektronik Kullanim Bilgileri
F=——N\

Bu yazilim, Elektronik Kullanim Bilgileri (elFU) olarak bir
operator el kitabi setiyle birlikte saglanir. Bu durum,
yazilimin lzerinde bulunan ve yukarida goriintilenen
simgenin kullanildigi bir etiketle belirtilir.

Uygulama ekraninin sag ust kdsesinde bulunan yardim
menisinden istedidiniz zaman operator el kitabi setine
erisebilirsiniz.

En yeni operatér el kitabi CD'sini indirmek ve igerigi
goruntilemek ya da yazdirmak igin:

1. https://www.gehealthcare.com/support/
support-documentation-library baglantisina
erisin

2. Modaliteler listesinden NM (NUkleer Tip) baglantisini
secin. Yeni bir sayfa acilir.

3. NM Products (NT Uriinleri) altindan NM (NT)
DaTQUANT Grinini segin.

4. Manual Types: CD (Manuel Tirler: CD) 6desini segin.

5. [Search] ([Ara]) segenegine tiklayin.

6. Download (indir) altindan uygun dildeki Operatér
CD'sini segin.

7. [Download Selected Files] ([Secilen Dosyalari indir])
segenegine tiklayin.

8. Copyright (Telif hakki) bilgilerini okuyun ve [ACCEPT]
([KABUL ET]) segenegine tiklayin.

9. [Save] ([Kaydet]) secenegine tiklayin ve dosya indirme
yolunu segin.

10. [Open Folder] ([Klasor Ag]) segenegine tiklayarak
indirilen sikistiriimig dosyay! agabilir ve igindekilere
ulasabilirsiniz.

Not: Yalnizca Avrupa Birligi liyesi bolgelerde gegerlidir

Sistemler birlikte saglanmadidi takdirde operator el kitabi

setinin bir kopyasi ek lcret ddemeden siparis edilebilir. Satis

veya Servis temsilcinize talebinizi génderebilirsiniz.

Talebiniz 7 gun iginde isleme konulacaktir.

Bu kopya sisteminizdeki elektronik kopyadan biraz farkli
olabilir. Gerekirse detayli agiklama icin yerel temsilcinize
basvurun.

Etiket Aciklama Etiket Aciklama Etiket Aciklama
simgesi simgesi simgesi
Katalog numarasi Uretici Kullanim Talimatlari elektronik
Referans numarasi d olarak sunulur
=
Uretim tarihi Bkz. Talimat kilavuzu/kitapgigi | Rx Only DIKKAT: Federal kanunlara
& @ gore bu cihaz sadece bir doktor
tarafindan veya doktor
siparigiyle satilabilir.
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